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1. INTRODUCTION

The RCM3400 is a compact module that incorporates the pow-
erful Rabbit 3000® microprocessor, flash memory, static RAM,
digital 1/0 ports, analog inputs, and PWM outputs.

The Development Kit has the essentials that you need to design
your own microprocessor-based system, and includes a com-
plete Dynamic C software development system. This Develop-
ment Kit also contains a Prototyping Board that will alow you
to evaluate the RCM 3400 and to prototype circuits that interface
to the RCM 3400 module. You will aso be able to write and test
software for the RCM3400 modules, including Ethernet or
TCP/IP applications.

The RCM3400 has a Rabbit 3000 microprocessor operating at 29.4 MHz, static RAM,
flash memory, a 12-bit 8-channel A/D converter, two clocks (main oscillator and time-
keeping), and the circuitry necessary for reset and management of battery backup of the
Rabbit 3000's internal real-time clock and the static RAM. Two 34-pin headers bring out
the Rabbit 3000 I/O bus lines, parallel ports, A/D converter channels, and serial ports.

The RCM3400 receives its +3.3 V power from the customer-supplied motherboard on
which it is mounted. The RCM 3400 can interface with all kinds of CMOS-compatible
digital devices through the motherboard.

1.1 RCM3400 Features

Small size: 1.16" x 1.37"" x 0.31"
(29 mm x 34 mm x 8 mm)

Microprocessor: Rabbit 3000 running at 29.4 MHz

47 paralel 5V tolerant 1/0 lines: 41 configurable for 1/0, 3 fixed inputs, 3 fixed outputs
Two additional digital inputs, one additional digital output

Eight single-ended or four differential analog inputs
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One additional analog input
External reset input

Alternate I/O bus can be configured for 8 data lines and 6 address lines (shared with
paralel 1/0 lines), 1/0O read/write

Ten 8-bit timers (six cascadable) and one 10-bit timer with two match registers

512K flash memory, 512K SRAM, (options for 256K flash memory and 256K SRAM)
Real-time clock

Watchdog supervisor

Provision for customer-supplied backup battery via connections on header J2

10-bit free-running PWM counter and four width registers

Two-channel Input Capture can be used to time input signals from various port pins

Two-channel Quadrature Decoder accepts inputs from external incremental encoder
modules

Five CMOS-compatible serial ports: maximum asynchronous baud rate of 5.5 Mbps.
Four ports are configurable as a clocked seria port (SPI), and two ports are config-
urable as SDLC/HDLC seria ports.

Supports 1.15 Mbps IrDA transceiver

There are two RCM 3400 production models. If the standard models do not serve your
needs, other variations can be specified and ordered in production quantities. Contact your
Z-World or Rabbit Semiconductor sales representative for details.

Table 1 below summarizes the main features of the RCM3400.

Table 1. RCM3400 Features

Feature RCM3400 RCM3410
Microprocessor Rabbit 3000 running at 29.4 MHz
Flash Memory 512K 256K
SRAM 512K 256K

5 shared high-speed, CMOS-compatible ports:
5 are configurable as asynchronous serial ports;
4 are configurable as clocked serial ports (SPI);
2 are configurable as SDLC/HDLC seria ports;
1 asynchronous serial port is used during
programming

Serial Ports

The RCM 3400 can be programed through connections on the motherboard supporting
RS-232, USB with an RS-232/USB converter, or over an Ethernet.

Appendix A provides detailed specifications for the RCM 3400.
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1.2 Advantages of the RCM3400

Fast time to market using a fully engineered, “ready-to-run/read-to-program” micro-
processor core.

Competitive pricing when compared with the aternative of purchasing and assembling
individual components.

Easy C-language program development and debugging

Program Download Utility and cloning board options for rapid production loading of
programs.

Generous memory size allows large programs with tens of thousands of lines of code,
and substantial data storage.

Reference design allows integrated Ethernet port for network connectivity, with
royalty-free TCP/IP software.
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1.3 Development and Evaluation Tools
1.3.1 Development Kit

The Development Kit contains the hardware essentials you will need to use your
RCM 3400 module. The itemsin the Development Kit and their use are as follows.

RCM 3400 module.
Prototyping Board.

AC adapter, 9V DC, 1 A. (Included only with Development Kits sold for the North
American market. A header plug leading to bare leads is provided to allow overseas
users to connect their own power supply with aDC output of 824 V.)

Getting Started instructions.

A bag of accessory parts for use on the Prototyping Board.
Rabbit 3000 Processor Easy Reference poster.
Registration card.

10-pin header to DE9 programming cable with integrated |evel-matching circuitry.
Dynamic C CD-ROM, with complete product documentation on disk.

AC Adapter
(North American
kits only)

0

Accessory Parts for

Programming
DIAG Cable
RO
Embedded

COMLo

RabbitCore RCM3400
Startea

Prototyping Board

il

Getting Started
Instructions

Prototyping Board

Figure 1. RCM3400 Development Kit
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1.3.2 Software

The RCM3400 is programmed using version 7.32 or later of Z-World's Dynamic C. A
compatible version is included on the Development Kit CD-ROM.

Z-World also offers add-on Dynamic C modules containing the popular uC/OS-1 real-
time operating system, as well as PPP, Advanced Encryption Standard (AES), and other
select libraries. In addition to the Web-based technical support included at no extra charge,
aone-year telephone-based technical support module is aso available for purchase. Visit
our Web site at www.zworld.com or contact your Z-World sales representative or autho-
rized distributor for further information.

1.3.3 Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-
mentation menu is placed on the workstation’s desktop. Double-click thisicon to reach the
menu. If theicon is missing, use your browser to find and load default.htm inthedocs
folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download
from our Web sites as well.
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2. GETTING STARTED

This chapter describes the RCM 3400 hardware in more detail, and
explains how to set up and use the accompanying Prototyping Board.

NOTE: Thischapter (and this manual) assume that you have the RCM 3400 Devel opment
Kit. If you purchased an RCM 3400 module by itself, you will have to adapt the infor-
mation in this chapter and el sewhere to your test and development setup.

2.1 Install Dynamic C

To develop and debug programs for the RCM 3400 (and for all other Z-World and Rabbit
Semiconductor hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C version 7.32 (or a later version), do so now by
inserting the Dynamic C CD from the RCM 3400 Development Kit in your PC's CD-ROM
drive. If autorun is enabled, the CD installation will begin automatically.

If autorun is disabled or the install ation otherwise does not start, use the Windows
Start | Run menu or Windows Disk Explorer to launch set up. exe from the root folder
of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the
process are self-explanatory.

Dynamic C usesa COM (seria) port to communicate with the target devel opment system.
The installation allows you to choose the COM port that will be used. The default selec-
tion is COM 1. You may select any available port for Dynamic C's use. If you are not cer-
tain which port is available, select COM1. This selection can be changed later within
Dynamic C.

NOTE: Theinstallation utility does not check the selected COM port in any way. Speci-
fying aport in use by another device (mouse, modem, etc.) may lead to a message such
as"coul d not open serial port" when Dynamic Cis started.

Once your installation is complete, you will have up to three icons on your PC desktop.
Oneiconisfor Dynamic C, one opens the documentation menu, and the third is for the
Rabbit Field Utility, atool used to download precompiled software to atarget system.
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2.2 Hardware Connections

There are three steps to connecting the Prototyping Board for use with Dynamic C and the
sample programs:

1. Attach the RCM 3400 module to the Prototyping Board.

2. Connect the programming cable between the RCM 3400 Prototyping Board and the
workstation PC.

3. Connect the power supply to the Prototyping Board.
2.2.1 Attach Module to Prototyping Board

Turn the RCM 3400 module so that the Rabbit 3000 chip is facing up and the Rabbit logo is
facing the direction shown in Figure 2 below. Align the module headers J1 and J2 into sockets
RCM1JA and RCM1JB on the Prototyping Board. The shaded corner notch at the top |eft cor-
ner of the RCM 3400 modul e should face the same direction as the corresponding notch below
it on the Prototyping Board.

RCM3400

00000000
IOO00000Q0
000

sssss

00000

xxxxxxxxxxxxxxx DOO0000
LO00000000000 Q00000 iﬂiﬁéwwzzbada ole
OOOOOOOOOOOOOOOOOOOOOO - C

0O0000000000000000000000000000OOC0000
DOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOC
0000000000000 000000000000000000000000000
0000000000000 000000000000000000000000000
0000000000000 00000000000000000000000000
0000000000000 00000000000000000000000000
OOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOC
00000000000 000 00000000000
DOOOOOOOOOOOOOOOOOO §

00000000000 00000Q0 Eu
00000000000 0000000
00000000000 0000000 ot
O000NQ00000000000000: -

" leYele)
“ XXXXXXXXXXXXXXXXXXXX 2C

HOOOOOOOOOOOOOC

000000000000

g 0000000000000 Q
o o 0000000000000000000000000Q
P AeEAan e aaEas 0000000000000000000000000AA

~[TIE  , oH oH =0 o8 50 =0 & o E@umm ﬁim OOOOOOOOOOOOOOOOOOOOOOOOOOC
o .t o oF oF o 0 8 00000000 Q

)(XXXXXXXXXXXXXXXXXXXXXXXX
S DEOO0OOOO000) @ {o}
e L

Figure 2. Install the RCM3400 Series Module on the Prototyping Board

NOTE: Itisimportant that you line up the pins on headers J1 and J2 of the RCM 3400
series module exactly with the corresponding pins of sockets RCM1JA and RCM 1JB
on the Prototyping Board. The header pins may become bent or damaged if the pin
alignment is offset, and the module will not work. Permanent el ectrical damage to the
module may also result if amisaligned module is powered up.

Press the modul€'s pins firmly into the Prototyping Board headers.
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2.2.2 Connect Programming Cable

The programming cable connects the RCM 3400 to the PC running Dynamic C to download
programs and to monitor the RCM 3400 module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on the
RCM 3400 Prototyping Board as shown in Figure 3. Be sure to orient the marked (usually red)
edge of the cable towards pin 1 of the connector. (Do not use the DIAG connector, which is
used for anormal seria connection.)

To
PC COM port

p

[ Programming
g2 |l “cavre
DE\
=

[ovad

3-pin
power connector

Reser

0000000000000000000000000)

plele 0 el0 e e 0 0l0 0 0 0 0 0 0 e 0 0101020 |

O O
DOOOOOOOOOOOOOOOOO
0000000000000 00000!
0000000000000000000_KAXLX.
00000Q0000Q00 OOOO R olele olel0 KRN

0000000

OOOOOOOOOOOOOOOOOOOOOOOOOC
00000000000

e 288888888888§§8888888888889
MW

S Sl -

RRTRRLIREICIE:
0000
0800
0000
0800
000!
000
000
233
300
000
200
000!
000
000
g2s2
30
Q0
S0
00
S0
000
%
300
000
200
000!
000
000
000
800

plelel0%¢

Figure 3. Connect Programming Cable and Power Supply

NOTE: Besureto usethe programming cable (part number 101-0542) supplied with this
Development Kit—the programming cable has blue shrink wrap around the RS-232
converter section located in the middle of the cable. Programming cables from other
Z-World or Rabbit Semiconductor kits were not designed to work with RCM 3400 mod-
ules.

Connect the other end of the programming cable to a COM port on your PC.

NOTE: Some PCsnow come equipped only with a USB port. It may be possible to use
an RS-232/USB converter with the programming cable supplied with the RCM 3400
series Development Kit. Contact Technical Support (see next page) for further assis-
tance.
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2.2.3 Connect Power

When all other connections have been made, you can connect power to the Prototyping Board.
Connect the wall transformer to jack J8 on the Prototyping Board as shown in Figure 3.

Plug in the wall transformer. The power LED on the Prototyping Board should light up. The
RCM 3400 and the Prototyping Board are now ready to be used.

NOTE: A RESET buttonis provided on the Prototyping Board to allow a hardware reset
without disconnecting power.

2.2.3.1 Overseas Development Kits

Development kits sold outside North Americainclude a header connector that may be con-
nected to 3-pin header J9 on the Prototyping Board. The connector may be attached either way
aslong asit is not offset to one side. The red and black wires from the connector can then be
connected to the positive and negative connections on your power supply. The power supply
should deliver 8V-24V DCat 1 A.
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2.3 Starting Dynamic C

Once the RCM 3400 is connected as described in the preceding pages, start Dynamic C by
double-clicking on the Dynamic C icon or by double-clicking on dcr abXXXX. exe in
the Dynamic C root directory, where XXXX are version-specific characters.

Dynamic C defaults to using the serial port on your PC that you specified during installa-
tion. If the port setting is correct, Dynamic C should detect the RCM 3400 and go through
a sequence of stepsto cold-boot the RCM 3400 and to compile the BIOS. (Some versions
of Dynamic C will not do theinitial BIOS compile and load until the first time you com-

pile aprogram.)

If you recelvethe message No Rabbit Processor Detect ed, the programming
cable may be connected to the wrong COM port, a connection may be faulty, or the target
system may not be powered up. First, check to see that the power LED on the Prototyping
Board islit and that the jJumper across pins 56 of header JP10 on the Prototyping Board is
ingtalled. If the LED islit, check both ends of the programming cable to ensurethat it is
firmly plugged into the PC and the programming port on the Prototyping Board. Ensure
that the module is firmly and correctly installed in its connectors on the Prototyping
Board.

If there are no faults with the hardware, select a different COM port within Dynamic C.
From the Options menu, select Project Options, then select Communications. Select
another COM port from the list, then click OK. Press <Ctrl-Y> to force Dynamic C to
recompilethe BIOS. If Dynamic C till reportsit is unable to locate the target system, repesat
the above steps until you locate the active COM port.You should should recieve a message
Bi os conpil ed successful | y oncethisstep iscompleted succcessfully.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-
cation error message when you compile and load a sample program, it is possible that your
PC cannot handle the higher program-loading baud rate. Try changing the maximum
download rate to a slower baud rate as follows.

» Locatethe Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Select aslower Max download baud rate.

If aprogram compiles and loads, but then loses target communication before you can
begin debugging, it ispossible that your PC cannot handle the default debugging baud
rate. Try lowering the debugging baud rate as follows.

» Locatethe Serial Options dialog in the Dynamic C Options > Project Options >
Communications menu. Choose a lower debug baud rate.

2.4 Run a Sample Program

Find the file PONG. C, which isin the Dynamic C SAMPLES folder. To run the program,
open it with the File menu, compileit using the Compile menu, and then run it by selecting
Run in the Run menu. The STDIO window will open on your PC and will display a small
square bouncing around in a box.
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2.5 Where Do | Go From Here?

If the sample program ran fine, you are now ready to go on to the sample programsin the
RCM 3400 User’s Manual (click the documentation icon on your PC) and to develop your
own applications. The sample programs can be easily modified for your own use. The user’s
manual also provides complete hardware reference information and software function callsfor
the RCM 3400, the Prototyping Board, the Ethernet reference design, and the optional
LCD/Keypad module.

For advanced development topics, refer to the Dynamic C User’s Manual and the
Dynamic C TCP/IP User’'s Manual, also in the online documentation set.

2.5.1 Standalone Operation of the RCM3400

The RCM 3400 must be programmed viathe RCM 3400 Prototyping Board or viaasimilar
arrangement on a customer-supplied board. Once the RCM 3400 has been programmed
successfully, remove the programming cable from the programming connector and reset
the RCM 3400. The RCM 3400 may be reset by removing, then reapplying power, or by
pressing the RESET button on the Prototyping Board. The RCM 3400 module may now be
removed from the Prototyping Board for end-use installation.

CAUTION: Power to the Prototyping Board or other boards should be disconnected
when removing or installing your RCM 3400 module to protect against inadvertent
shorts across the pins or damage to the RCM 3400 if the pins are not plugged in cor-
rectly. Do not reapply power until you have verified that the RCM 3400 module is
plugged in correctly.

2.5.2 Technical Support

NOTE: If you purchased your RCM 3400 through a distributor or through a Z-World or
Rabbit Semiconductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:

* Check the Z-World/Rabbit Semiconductor Technical Bulletin Board at
www.zworld.com/support/bb/.

» Usethe Technical Support e-mail form at www.zworld.com/support/support _submit.html.
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3. RUNNING SAMPLE PROGRAMS

To develop and debug programs for the RCM 3400 (and for all
other Z-World and Rabbit Semiconductor hardware), you must
install and use Dynamic C. This chapter provides a tour of its
major features with respect to the RCM 3400.

3.1 Introduction

To help familiarize you with the RCM 3400 modules, Dynamic C includes several sample
programs. Loading, executing and studying these programswill give you a solid hands-on
overview of the RCM3400's capabilities, as well as aquick start with Dynamic C asan
application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of ANSI
C. If you do not, see the introductory pages of the Dynamic C User’s Manual for a sug-
gested reading list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your RCM 3400 must be plugged in to the Prototyping Board as described in Chapter 2,
“Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the Prototyping
Board to your PC.

4. Power must be applied to the RCM 3400 through the Prototyping Board.

Refer to Chapter 2, “ Getting Started,” if you need further information on these steps.
To run asample program, open it with the File menu (if it is not still open), compileit
using the Compile menu (or press F5), and then run it by selecting Run in the Run menu

(or press F9). The RCM 3400 must be in Program Mode (see Figure 4) and must be con-
nected to a PC using the programming cable.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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3.2 Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the
RCM3400. These programs will be found in the Sanpl es\ RCV3400 folder.

We suggest that you examine the following five sample programsin order to get afeel for
the capabilities of the RCM 3400 modules.

e CONTROLLED. c—Demonstrates use of the digital inputs by having you turn the LEDs
on the Prototyping Board on or off from the STDIO window on your PC.

Once you compile and run CONTROLLCD. C, the following display will appear in the
Dynamic C STDIO window.

E_Ilﬁl?

ool Proto-hoard LED'a e
nsl [
] orrF

From FC kevhomcd:

Selext 1%031 cr d=0EL o toggle LED'a

< Freas 2 To Quit =

4 .

Press“1” or “2” on your keyboard to select LED DS1 or DS2 on the Prototyping
Board. Then follow the prompt in the Dynamic C STDIO window to turn the LED ON

or OFF.
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* FLASHLED1. c—Demonstrates assembly-language program by flashing LEDs DS1
and DS2 on the Prototyping Board at different rates.

¢ FLASHLED2. c—Demonstrates cofunctions and costatements to flash LEDs DS1 and
DS2 on the Prototyping Board at different rates.

* | R_DEMO. c—Demonstrates sending Modbus ASCI| packets between two
RCM 3400/Prototyping Board assemblies viathe IrDA transceivers.

To use this sample program, you will need a second system with IrDA capability such
as another RCM 3400 with an RCM 3400 Prototyping Board, or an RCM 3000 with an
RCM 3000 Prototyping Board. First, compile and run the | R_DEMO. C sample program
from the SAMPLES folder specific to the other system on the second system, then move
the programming cable to the RCM 3400 Prototyping Board, and compile and run the

I R_DEMO. C sample program from the SAMPLES\ RCM3400 folder on the RCM 3400
system. With the IrDA transceivers on the two Prototyping Boards facing each other,
press switch S2 on the RCM 3400 Prototyping Board to transmit a packet. The other
system will return a response packet that will then appear in the Dynamic C STDIO
window.

Bant tast packet: :M1OL54E5T3IT4EIEEETED
Got packak! 0102548573 T4696E6TEL

Bisgwm:23
Racalved response Crom Oxl
Bant tast pachet: :010154E5T3IT4E9EEETED

Bant tast packet! :010L5465T3ITIEIEEETED

Got packaet: :01025485T73IT4E96E6TEL

¥

Bigm: 25

Racaived response From Oxl

Sank tast packhet: :010154E5TIT4EIEEETED

Sot pachat! :010254E5TIT4EIEESTEL

¥r

Qiga: 25

Racalved response Foom Oxl

Sant test pachet! :M1O154E5T3IT4EIEESTED

Got packaet: :01025485T73IT4E96E6TEL

¥

Bigm: 25

Racaived response From Oxl

Sank tast packhet: :010154E5TIT4EIEEETED

Sot pachat! :010254E5TIT4EIEESTEL

¥

Qiga: 25

Racalved response Foom Oxl

Sant test pachet! :M1O154E5T3IT4EIEESTED

4 .
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e TOGGLESW TCH. c—Uses costatements to detect switches using the press and release
method for debouncing. The corresponding LEDs (DS1 and DS2) will turn on or off.

Once you have loaded and executed these five programs and have an understanding of
how Dynamic C and the RCM 3400 modules interact, you can move on and try the other
sample programs, or begin building your own.

» Sample programs demonstrating the A/D converter operation and serial communication
associated with the Prototyping Board are described in Appendix B.

» Sample programs demonstrating the TCP/IP associated with the Prototyping Board are
described in Appendix C.

» Sample programs for the optional L CD/keypad module are described in Appendix D.
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3.3 Programming Cable

The RCM3400 is automatically in program mode when the PROG connector on the pro-
gramming cable is attached, and is automatically in run mode when no programming cable
Is attached.

The DIAG connector of the programming cable may be used on header J2 of the RCM 3400
Prototyping Board with the RCM 3400 operating in the run mode. This allows the pro-
gramming port to be used as an application port. See Appendix F, “Programming Cable,”
for more information.

To
PC COM port Q
o § M Programming ﬂ
B2 Cabie™ /T Tooue |
% Colored

[Towal]

Q
)

O] |L0]I
O

2000000000
YJO000000000000

000000000000000000000000000000000000000)

AAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAAA

RESET RCM3400 when changing mode:
Short out pins 1-32 on header J2, OR
Press RESET button (if using Prototyping Board), OR
Remove, then reapply power

after removing or attaching programming cable.

Figure 4. Switching Between Program Mode and Run Mode

3.3.1 Changing from Program Mode to Run Mode

1. Disconnect the programming cable from header J2 on the Prototyping Board.
2. Reset the RCM 3400. You may do this as explained in Figure 4.

The RCM3400 is now ready to operate in the run mode.

3.3.2 Changing from Run Mode to Program Mode

1. Attach the programming cable to header J2 on the Prototyping Board.

2. Reset the RCM3400. You may do thisas explained in Figure 4.

The RCM3400 is now ready to operate in the program mode.
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4. HARDWARE REFERENCE

Chapter 3 describes the hardware components and principal hardware
subsystems of the RCM3400. Appendix A, “RCM3400 Specifica-
tions,” provides complete physical and e ectrical specifications.

Figure 5 shows the Rabbit-based subsystems designed into the RCM 3400.

External
A/D Converter scaling

circuitry

SRAM RABBIT™ logic-level serial signal

3000
Flash
Level
converter
32 kHz | [29.4 MHz
osc osc RS-232, RS-485,
IrDA and Ethernet
RabbitCore Module drivers on motherboard

Figure 5. RCM3400 Subsystems
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4.1 RCM3400 Digital Inputs and Outputs
Figure 6 shows the RCM 3400 pinouts for headers J1 and J2.

J2 J1
GND [ |®m o[ ] PF1 LN3[_|®m o[ JLN7
PB6 |0 o[ JPFO LN2[]o o|JLN6
PB5 o o[ ] PB4 LN1C]o o[ JLN5
PB3 o o[ PB2 LNOC]o o[ JLN4
PB1 o o[ JPA7 BVREF | o ©[ ] CONVERT
PA6 o o[ ] PA5 PF6 |0 o[ 1PF7
PA4[|o o[ 1PA3 PF4A[|o o|_JPF5
PA2 o o[ PA1 PB7 |0 o[ ] PE7
PC2 o o[ JPAO PE6 | o o[ PE5
PCco|o o[ JPC3 PE4[|o o[ PE2
PC6-TxA | o o[ PC1 PE1C o o[ PEO
PC7-RxA[]o o[ 1 PG3 GND[ = o[ J+33V_IN
PG2 o o[ PG1 PG7|o o[ PG6
PGO L] © o[ JPDO PG5 |0 o[ PG4
PD4 o o[ JPD5 /IORD | o o[ STATUS
PD6 | o[ 1/RESET_IN SMODE1[|o o[ ]/IOWR
PD7 | o o[ VBAT_EXT /JRES| o o[ SMODEO
n.c. = not connected
Note: These pinouts are as seen on
the Bottom Side of the module.

Figure 6. RCM3400 Pinouts

Headers J1 and J2 are standard 2 x 34 headers with anominal 1.27 mm pitch.
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Figure 7 shows the use of the Rabbit 3000 microprocessor portsin the RCM 3400 modules.

RCM3400 I/O pins.

PDO
PAO-PA7 PB1-PB7 PD4—-PD7
Port A Port B Port D
PCO, PC2 Port C Port E PEO-PE2
PC1 pogﬂ (Serial Ports C &.0) | I SVY=T:Tp il o PRA-PET
PG2, PG6 Port G 3000 Port F PFO-PF1
PG3. PG7 (Serial Ports E & F) PF4-PF7
PB1, PC6 Programming Real-Time Clock Port G
Port - PGO-PG7
PC7, IRES : (Serial Port A) Watchdog L ——
11 Timers
* /RES_IN
PC4 ﬂ A/D Converter Slave Port Misc. I/O /IORD
. (Serial Port B) /RESET,
PC5 Clock Doubler /IOWR,
Backib Batt STATUS
* PC4 and PC5 ackup Batte SMODEO
not ae\‘/gilable :rrie RAM Sugport e Flash SMODE1

The ports on the Rabbit 3000 microprocessor used in the RCM 3400 are configurable, and
so the factory defaults can be reconfigured. Table 2 lists the Rabbit 3000 factory defaults

Figure 7. Use of Rabbit 3000 Ports

and the alternate configurations.
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Table 2. RCM3400 Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes
1 LN3 Input
2 LN7 Input
3 LN2 Input
4 LNG Input A/D converter
6 LN5 Input
7 LNO Input
8 LN4 Input
9 BVREF Analog Output 115 \_//2.048 V/2.500 V
on-chip ref. voltage
10 CONVERT |Input
AQD2B
11 PF6 I nput/Output PWM2
AQD2A
12 PF7 I nput/Output PWM3
=
o AQD1B
-§ 13 PF4 I nput/Output PWMO
I
AQD1A
14 PF5 I nput/Output PWM1
IA5 External Address 5
15 PB7 I nput/Output
P LTpu JSLAVEATTN Slave Attention
16 PE7 I nput/Output 7
R /SCS
17 PE6 I nput/Output 16
18 PE5S I nput/Output 1S
puttAlp INT1B
19 PE4 I nput/Output 14
P INTOB
20 PE2 I nput/Output 12
11 1/0O Strobe 1
21 PE1 I nput/Output
ApurUtpu INT1A Interrupt 1A
10 1/0O Strobe 0
22 PEO I nput/Output
pULLTD INTOA Interrupt OA
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Table 2. RCM3400 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
23 GND
24 +3.3V_IN
25 PG7 I nput/Output RXE
Seria Port E
26 PG6 I nput/Output TXE
27 PG5 I nput/Output RCLKE Serial Clock E input
28 PG4 I nput/Output TCLKE Serial Clock E output
29 /IORD Input External read strobe
30 STATUS Output (Status) Output
(SMODE1, SMODEQ)
(0,0)—start executing at address zero
o (0,2)—cold boot from slave port
= - .
% 31 SMODEL (1,0)—cold boot from clocked Serial Port A Programming port
I SMODEO =1, SMODE1 =1
Cold boot from asynchronous Serial Port A at
2400 bps (programming cable connected)
32 /IOWR Output External write strobe
33 IRES Reset output Reset input Reset outpuit from Reset
Generator
(SMODE1, SMODEQ)
(0,0)—start executing at address zero
(0,2)—cold boot from slave port
3 SMODEO (1,0)—cold boot from clocked Serial Port A Programming port
SMODEO =1, SMODE1 =1
Cold boot from asynchronous Serial Port A at
2400 bps (programming cable connected)
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Table 2. RCM3400 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes
1 GND
QD1A
2 PF1 I nput/Output CLKC
3 PB6 I nput/Output I1A4 External Address 4
QD1B
4 PFO I nput/Output CLKD
IA3 External Address 3
5 PB5 I nput/Output
P pu SAl Slave port Address 1
IA2 External Address 2
6 PB4 I nput/Output
np pu SAOQ Slave port Address 0
1Al External Address 1
7 PB3 I nput/Output
p pu /SRD Slave port read
IAO External Address 0
8 PB2 I nput/Output
P pu /ISWR Slave port write
9 PB1 I nput/Output CLKA
Externa data bus
ID7-1D1
Y [10-16 |PA[7:1] Paralel 1/0 ( )
o Slave port data bus
'g (SD7-SD1)
T
17 PC2 Output TXC Serial Port C
External data bus (1D0) .
18 PAO Paralel 1/0 High
o Slave port data bus (SDQ) 'g
19 PCO Output TXD Serial Port D
20 PC3 I nput RXC Seria Port C
21 PC6 Output TXA Programming port
22 PC1 Input RXD Serial Port D
23 PC7 I nput RXA Programming port
24 PG3 I nput/Output RXF
Serial Port F
25 PG2 I nput/Output TXF
26 PG1 I nput/Output RCLKF Serial Clock F input
27 PGO I nput/Output TCLKF Serial Clock F output
28 PDO I nput/Output
29 PD4 I nput/Output ATXB
30 PD5 I nput/Output ARXB
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Table 2. RCM3400 Pinout Configurations (continued)

Pin Pin Name Default Use Alternate Use Notes

31 PD6 I nput/Output ATXA
% 32 /RESET_IN | Input Input to Reset Generator
§ 33 PD7 I nput/Output ARXA

34 VBAT_EXT
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4.1.1 Memory I/O Interface

The Rabbit 3000 address lines (A0-A19) and all the data lines (D0O-D7) are routed inter-
nally to the onboard flash memory and SRAM chips. I/0 write (/IOWR) and 1/0 read
(/IORD) are available for interfacing to external devices.

Parallel Port A can also be used as an external 1/0 databusto isolate external 1/0O from the
main data bus. Parallel Port B pins PB2—PB7 can also be used as an auxiliary address bus.

When using the auxiliary 1/0 busfor either Ethernet or the L CD/keypad module on the
Prototyping Board or for any other reason, you must add the following line at the begin-
ning of your program.

#defi ne PORTA_AUX | O /1 required to enable auxiliary 1/0O bus

The STATUS output has three different programmable functions:

3. It can be driven low on the first op code fetch cycle.

4. 1t can be driven low during an interrupt acknowledge cycle.
5. It can also serve as a general -purpose output.

4.1.2 Other Inputs and Outputs

Two start-up mode pins, SMODEO and SMODEL, are available as inputs. The logic state
of these two pins determines the startup procedure after a reset.

/RESET _IN isan external input used to reset the Rabbit 3000 microprocessor and the
RCM 3400 memory. /RES is an output from the reset circuitry that can be used to reset
other peripheral devices.
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4.2 Serial Communication

The RCM 3400 board does not have any serial transceivers directly on the board. How-
ever, an Ethernet or other serial interface may be incorporated on the board the RCM 3400
is mounted on. For example, the Prototyping Board has RS-232, RS-485, IrDA, and
Ethernet transceiver chips.

4.2.1 Serial Ports

There arefive serial ports designated as Serial Ports A, C, D, E, and F. All five serial ports
can operate in an asynchronous mode up to the baud rate of the system clock divided by 8.
An asynchronous port can handle 7 or 8 data bits. A 9th bit address scheme, where an
additional bit is sent to mark the first byte of a message, is also supported. Serial Ports A,
B, C, and D can aso be operated in the clocked serial mode. In thismode, a clock line syn-
chronously clocks the datain or out. Either of the two communicating devices can supply
the clock.

Serial Ports E and F can aso be configured as SDL C/HDLC serial ports. The IrDA proto-
col isalso supported in SDLC format by these two ports.

4.2.2 Programming Port

The RCM3400 is accessed using a 10-pin program header labeled J2 on the Prototyping
Board. The programming port uses the Rabbit 3000’s Serial Port A for communication,
and is used for the following operations.

» Programming/debugging
e Cloning

» Remote program download/debug over an Ethernet connection via the RabbitLink
EG2100

The programming port is used to start the RCM 3400 in a mode where the RCM 3400 will
download a program from the port and then execute the program. The programming port
transmits information to and from a PC while a program is being debugged.

The Rabbit 3000 startup-mode pins (SMODEO, SMODEZ1) are presented to the program-
ming port so that an externally connected device can force the RCM 3400 to start up in an
external bootstrap mode. The RCM 3400 can be reset by Dynamic C viathe/RES_IN line
on the programming port.

The Rabbit 3000 status pin is also presented to the programming port. The status pinisan
output that can be used to send a general digital signal.

NOTE: Refer to the Rabbit 3000 Microprocessor User’s Manual for more information.
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4.2.2.1 Alternate Uses of the Programming Port

The programming port may also be used as an application port with the DIAG connector
on the programming cable.

All three clocked Serial Port A signals are available as

e asynchronous serial port

» an asynchronous serial port, with the clock line usable as a genera CMOS input
* two general-purpose CMOS inputs and one general-purpose CMOS output.

Two startup mode pins, SMODEO and SMODEL, are available as general CMOS inputs
after they are read during the initial boot-up. The logic state of these two pins determines
the startup procedure after areset.

/RES_IN isan external input used to reset the Rabbit 3000 microprocessor.
The status pin may also be used as a general CMOS output.
See Appendix F, “Programming Cable,” for more information.
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4.3 A/D Converter

The RCM 3400 has an onboard ADS7870 A/D converter whose scaling and filtering are
done via the motherboard on which the RCM 3400 module is mounted. The A/D converter
multiplexes converted signals from eight single-ended or four differential inputsto Serial
Port B on the Rabbit 3000.

The eight analog input pins, LNO-LN7, each have an input impedance of 6-7 MQ,
depending on whether they are used as single-ended or differential inputs. The input signal
canrangefrom -2V to +2 V (differential mode) or from 0V to +2 V (single-ended mode).

Use aresistor divider such asthe one shown in Figure 8 for the analog inputs.

N RCM3400

LNO ADC
LN1 L —

AGND

I
@
<
Py
m
ul

Figure 8. Resistor Divider Network for Analog Inputs

RO and R1 are typically 20 kQ to 100 kQ, with alower resistance leading to more accu-
racy, but at the expense of a higher current draw. R10 and R11 would then be 180 kQ to
900 kQ for a 10:1 attenuator. The capacitor filters noise pulses on the A/D converter input.

The actual voltage range for asignal going to the A/D converter input is also affected by
thel, 2,4, 5. 8, 10, 16, and 20 V/V software-programmable gains available on each chan-
nel of the ADS7870 A/D converter. Thus, you must scale the analog signal with an attenu-
ator circuit and a software-programmable gain so that the actual input presented to the
A/D converter iswithin the range limits of the ADS7870 A/D converter chip(-2V to+2V
or0Vto+2V).

The A/D converter chip can only accept positive voltages. With resistors RO and R1 con-
nected to ground, your analog circuit is well-suited to perform positive A/D conversions.
When RO and R1 aretied to ground for differential measurements, both differential inputs
must be referenced to analog ground, and both inputs must be positive with respect to ana-
log ground.

User’s Manual 29



If adevice such asabattery is

connected across two channels

for a differential measurement, A0 e o ADC
and it isnot referenced to
analog ground, then the current
from the device will flow
through both sets of attenuator
resistors as shown in Figure 9.
Thiswill generate a negative
voltage at one of the inputs,
LN1, which will almost cer- Figure 9. Current Flow from Ungrounded

tainly lead to inaccurate A/D or Floating Source

conversions. To make such dif-

ferential measurements, connect RO and R1 to the A/D converter’s internal reference volt-
age, which is software-configurable for 1.15V, 2.048V, or 2.5 V. This internal reference
voltage is available on pin 9 of header J1 as BV REF, and allows you to convert analog
input voltages that are negative with respect to analog ground.

LN1

NOTE: Theamplifier inside the A/D converter’s internal voltage reference circuit has a
very limited output-current capability. The internal buffer can source up to 20 mA and
sink only up to 20 pA. Use a separate buffer amplifier if you need to supply any load
current.

The A/D converter’s CONVERT pinisavailable on pin 10 of header J1 and can be used as
ahardware means of forcing the A/D converter to start a conversion cycle. The CONVERT
signal is an edge-triggered event and has ahold time of two CCLK periods for debounce.

A conversion is started by an active (rising) edge on the CONVERT pin. The CONVERT
pin must stay low for at least two CCLK periods before going high for at least two CCLK
periods. Figure 10 shows the timing of a conversion start. The double falling arrow on
CCLK indicates the actual start of the conversion cycle.

Conversion starts
BUSY /
CONV / \

Figure 10. Timing Diagram for Conversion Start Using CONVERT Pin

Appendix B explains the implementation examples of these features on the Prototyping
Board.
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4.3.0.1 A/D Converter Power Supply

The analog section isisolated from digital noise generated by other components by way of a
low-pass filter composed of L1, C10, and C15 on the RCM 3400 as shown in Figure 11. The
+V analog power supply powersthe A/D converter chip.

Vce +V

C15 C10

j|:2.2 nF j|:100 nF

Figure 11. Analog Supply Circuit
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4.4 Other Hardware
4.4.1 Clock Doubler

The RCM 3400 takes advantage of the Rabbit 3000 microprocessor’s internal clock dou-
bler. A built-in clock doubler allows half-frequency crystals to be used to reduce radiated
emissions. The 29.4 MHz frequency specified for the RCM 3400 is generated using a
14.7 MHz resonator.

The clock doubler may be disabled if 29.4 MHz clock speeds are not required. Disabling
the Rabbit 3000 microprocessor’s internal clock doubler will reduce power consumption
and further reduce radiated emissions. The clock doubler is disabled with a smple change
to the BIOS as described below.

1. Open the BIOS source code file, RABBI TBI CS. Cin the Bl CS directory.

2. Changetheline

#define CLOCK DOUBLED 1 // set to 1 to double clock if
/1 Rabbit 2000: crystal <= 12.9024 Mz,
/1 Rabbit 3000: crystal <= 26.7264 M1z,
/1 or to O to always disable cl ock doubler

to read asfollows.
#define CLOCK_DOUBLED 0
3. Save the change using File > Save.

NOTE: The clock doubler must be disabled for low-voltage operation (2.8 V-3.0 V).
4.4.2 Spectrum Spreader

The Rabbit 3000 features a spectrum spreader, which helpsto mitigate EMI problems. By
default, the spectrum spreader is on automatically, but it may also be turned off or set to a
stronger setting. The means for doing so isthrough a simple change to the following BIOS
linein away that is similar to the clock doubler described above.

#def i ne ENABLE_SPREADER 1 /1l Set to O to disable spectrum spreader,
/1 1 to enable normal spreading, or
/1 2 to enable strong spreading.

NOTE: The strong spectrum-spreading setting is not recommended since it may limit the
maximum clock speed or the maximum baud rate. It is unlikely that the strong setting
will be used in areal application.

NOTE: Refer to the Rabbit 3000 Microprocessor User’s Manual for more information
on the spectrum-spreading setting and the maximum clock speed.
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4.5 Memory
4.5.1 SRAM

RCM 3400 series boards have 256K-512K of SRAM installed at U6 and packaged in a 32-
pin sTSOP case.

4.5.2 Flash EPROM

RCM 3400 series boards also have 256K-512K of flash EPROM packaged in a 32-pin
STSOP case.

NOTE: Z-World recommends that any customer applications should not be constrained
by the sector size of the flash EPROM since it may be necessary to change the sector
sizein the future.

Writing to arbitrary flash memory addresses at run timeis also discouraged. Instead,
definea*“user block” areato store persistent data. The functionswr i t eUser Bl ock and
r eadUser Bl ock are provided for this.

A Flash Memory Bank Select jumper configuration option based on 0 Q surface-mounted
resistors exists at header JP2 on the RCM 3400 modules. This option, used in conjunction
with some configuration macros, allows Dynamic C to compile two different co-resident
programs for the upper and lower halves of the 512K flash in such away that both pro-
grams start at logical address 0000. Thisis useful for applications that require a resident
download manager and a separate downloaded program. See Technical Note 218, Imple-
menting a Serial Download Manager for a 256K Flash, for details.

4.5.3 Dynamic C BIOS Source Files

The Dynamic C BIOS sourcefiles handle different standard RAM and flash EPROM sizes
automatically.
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5. SOFTWARE REFERENCE

Dynamic C is an integrated development system for writing
embedded software. It runs on an IBM-compatible PC and is
designed for use with Z-World controllers and other controllers
based on the Rabbit microprocessor. Chapter 3 provides the
libraries, function calls, and sample programs related to the
RCM 3400.

5.1 More About Dynamic C

Dynamic C has been in use worldwide since 1989. It is specially designed for program-
ming embedded systems, and features quick compile and interactive debugging in the real
environment. A complete reference guide to Dynamic C is contained in the Dynamic C
User’s Manual.

You have a choice of doing your software development in the flash memory or in the static
SRAM included on the RCM3400. The advantage of working in RAM isto save wear on
the flash memory, which islimited to about 100,000 write cycles. The disadvantage isthat
the code and data might not both fit in RAM.

NOTE: An application can be developed in RAM, but cannot run standalone from RAM
after the programming cable is disconnected. All standal one applications can only run
from flash memory.

NOTE: Do not depend on the flash memory sector size or type. Dueto the volatility of
the flash memory market, the RCM 3400 and Dynamic C were designed to accommo-
date flash devices with various sector sizes.

The disadvantage of using flash memory for debug is that interrupts must be disabled for
approximately 5 ms whenever abreak point is set in the program. This can crash fast inter-
rupt routines that are running while you stop at a break point or single-step the program.
Theflash memory and SRAM options are selected with the Options > Program Options >
Compiler menu.

Dynamic C provides a number of debugging features. You can single-step your program,
either in C, statement by statement, or in assembly language, instruction by instruction.
You can set break points, where the program will stop, on any statement. You can evaluate
watch expressions. A watch expression is any C expression that can be evaluated in the
context of the program. If the programis at a break point, awatch expression can view any
expression using local or global variables. If aperiodic call tor unwat ch() isincludedin
your program, you will be able to evaluate watch expressions by hitting <Ctrl-U> without
stopping the program.
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5.2 Dynamic C Libraries

With Dynamic C running, click File > Open, and select Lib. The following list of
Dynamic C libraries will be displayed.

open — @H|

Loak i I e j gl

|1 Biosiit Oz (1 Rabhbit3000 (ter
1 BI2000 [ lcom A Rem3400 [dTo
I BIZ100 [ Jrablib (A 5m000 (e
| Dizplays 3 K.evpads [ SlavePart [ zex
|1 FileSpstern (1 0pes00 (0 Smrtstar EO
1 Gps ([J0p7200 CAspi Ch
1] | i
File name: I | Open I
Filez of type: ISI:IL,I[CE Files [*.c:® lib] j Cancel |

One library directory provides function calls that are used to develop applications for the
RCM 3400.

* RCMVB400—Tlibraries associated with features specific to the RCM 3400. These func-
tionsin the RCM34xx. LI B library illustrate the use of the RCM 3400 module on the
Prototyping Board, and are described in Section B.7.

Other generic functions applicable to all devices based on Rabbit microprocessors are
described in the Dynamic C Function Reference Manual.
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5.2.1 Digital /O

The RCM 3400 was designed to interface with other systems, and so there are no drivers
written specifically for the I/O. The general Dynamic C read and write functions allow
you to customize the parallel 1/0 to meet your specific needs. For example, use

W Port | (PEDDR, &PEDDRShadow, 0x00);
to set all the Port E bits as inputs, or use

W Port | ( PEDDR, &PEDDRShadow, OxFF);
to set all the Port E bits as outputs.

When using the auxiliary 1/0 bus on the Rabbit 3000 chip, add the line

#defi ne PORTA_AUX | O /1 required to enable auxiliary 1/0O bus
to the beginning of any programs using the auxiliary 1/0 bus.

The sample programs in the Dynamic C SAMPLES/ RCVB400 directory provide further
examples.
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5.2.2 Serial Communication Drivers

Library filesincluded with Dynamic C provide afull range of serial communications sup-
port. The RS232. LI B library provides a set of circular-buffer-based serial functions. The
PACKET. LI B library provides packet-based serial functions where packets can be delim-
ited by the 9th bit, by transmission gaps, or with user-defined special characters. Both
libraries provide blocking functions, which do not return until they are finished transmit-
ting or receiving, and nonblocking functions, which must be called repeatedly until they
are finished. For more information, see the Dynamic C Function Reference Manual and
Technical Note 213, Rabbit 2000 Serial Port Software.

5.2.3 TCP/IP Drivers
The TCP/IP drivers are located in the TCPI P directory.

open @R
Lookin: |2l topip [ ﬁl
Slituplin FTP_CLIENT LIE M fib Realtek

=] sinlib FTP_SERVER.LIE |2 MNe2000.ib smec.li
Eoatp.lib Hitp.ib net.lib Srtp. it
%] Badname.lib lcmplib Metemrno.lib tep.lib

dertcp.lib lgmp.lib Plidre.lib tcp_con

%) dns.lib ip.ib Popalib Thtp.lib
L | 2
File name: I Open I
Files of twpe: |S|:|urce Files [*.c:* lib] j Cancel |

Complete information on these libraries and the TCP/IP functionsis provided in the
Dynamic C TCP/IP User’'s Manual.
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5.3 Upgrading Dynamic C

Dynamic C patches that focus on bug fixes are available from time to time. Check the Web
sites

* www.zworld.com/support/

or

* www.rabbitsemiconductor.com/support/

for the latest patches, workarounds, and bug fixes.

The default installation of a patch or bug fix isto install the filein adirectory (folder) dif-
ferent from that of the original Dynamic C installation. Z-World recommends using a dif-
ferent directory so that you can verify the operation of the patch without overwriting the
existing Dynamic Cinstallation. If you have made any changesto the BIOS or to libraries,
or if you have programsin the old directory (folder), make these same changes to the
BIOS or librariesin the new directory containing the patch. Do not simply copy over an
entire file since you may overwrite a bug fix. Once you are sure the new patch works
entirely to your satisfaction, you may retire the existing installation, but keep it available
to handle legacy applications.

5.3.1 Upgrades

Dynamic C installations are designed for use with the board they are included with, and
areincluded at no charge as part of our low-cost kits. Dynamic C is a complete software
development system, but does not include all the Dynamic C features. Z-World also offers
add-on Dynamic C modules containing the popular uC/OS-1 real-time operating system,
aswell as PPP, Advanced Encryption Standard (AES), and other select libraries. In addi-
tion to the Web-based technical support included at no extra charge, a one-year telephone-
based technical support module is also available for purchase.
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APPENDIX A. RCM3400 SPECIFICATIONS

Appendix A provides the specifications for the RCM 3400, and
describes the conformal coating.
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A.1 Electrical and Mechanical Characteristics
Figure A-1 shows the mechanical dimensions for the RCM3400.
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Figure A-1. RCM3400 Dimensions
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It is recommended that you allow for an “exclusion zone” of 0.04" (1 mm) around the
RCM3400 in al directions when the RCM 3400 is incorporated into an assembly that
includes other printed circuit boards. This “exclusion zone’ that you keep free of other
components and boards will allow for sufficient air flow, and will help to minimize any
electrical or electromagnetic interference between adjacent boards. An “exclusion zone’
of 0.08" (2 mm) isrecommended below the RCM 3400 when the RCM 3400 is plugged
into another assembly using the shortest connectors for headers J1 and J2. Figure A-2

shows this “exclusion zone.”
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Figure A-2. RCM3400 “Exclusion Zone”
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Table A-1 liststhe electrical, mechanical, and environmenta specifications for the RCM 3400.

Table A-1. RabbitCore RCM3400 Specifications

Parameter

RCM3400 RCM3410

Microprocessor

Low-EMI Rabbit 3000™ at 29.4 MHz

Flash Memory 512K x 8, surface mount 256K x 8, surface mount
SRAM 512K x 8, surface mount 256K x 8, surface mount
Connection for user-supplied backup battery
Backup Battery (to support RTC and SRAM)
8 channels single-ended (11 bit) or 4 channels differential (12 bit)
Analog Inputs Programmable gain 1, 2, 4, 5, 8, 10, 16, and 20 V/V

A/D conversion time (including 120 ps raw count and Dynamic C) 180 us

General-Purpose I/0

47 parallel digital 1/0 lines:
* 41 configurable I/O
 3fixed inputs
« 3fixed outputs

Additional Inputs

Startup mode (2), reset in, CONVERT

Additional Outputs

Status, reset out, BVREF

Auxiliary 1/0 Bus

Can be configured for 8 data lines and
6 address lines (shared with parallel 1/0O lines), plus I/O read/write

5 shared high-speed, CM OS-compatible ports:

¢ al 5 configurable as asynchronous (with IrDA), 3 as clocked serial
(SPI), and 2 as SDLC/HDLC (with IrDA)

Seria Ports
* 1 asynchronous serial port dedicated for programming
¢ Support for MIR/SIR IrDA transceiver
Serial Rate M aximum asynchronous baud rate = CLK/8

Slave Interface

A dave port allows the RCM 3400 to be used as an intelligent peripheral
device daved to a master processor, which may either be another Rabbit
3000 or any other type of processor

Real-Time Clock Yes

Timers Ten 8-bit timers (6 cascadable), one 10-hit timer with 2 match registers

Watchdog/Supervisor Yes

Pulse-Width Modulators 10-bit free-running counter and four pulse-width registers

Input Capture 2—channel input capture can be used to time input signals from various
port pins

Quadrature Decoder 2-channel quadrature decoder accepts inputs from external incremental

encoder modules
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Table A-1. RabbitCore RCM3400 Specifications (continued)

Parameter

RCM3400 RCM3410

Power

3.0-345V DC @ 29.4 MHz, 2.8-3.45V DC @ 14.7 MHz
97mA @3.3V, 29.4 MHz; 57 mA at 3.0V, 14.7 MHz

Operating Temperature

—40°C to +85°C

Humidity 5% to 95%, noncondensing
Connectors Two 2 x 17, 1.27 mm pitch
Board Size 1.160" x 1.375" x 0.31

(29.5 mm x34.9 mm x 22 mm)

A.1.1 Headers

The RCM 3400 uses headers at J1 and J2 for physical connection to other boards. J1 and J2
are2 x 17 SMT headers with a 1.27 mm pin spacing.

Figure A-3 shows the layout of another board for the RCM 3400 to be plugged into. These
values are relative to the designated fiducial.

RCM3400 Footprint J2

|
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|

! 0.900
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|

|

I

|

I

Figure A-3. User Board Footprint for RCM3400
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A.2 Bus Loading

You must pay careful attention to bus loading when designing an interface to the
RCM3400. This section provides bus loading information for external devices.

Table A-2 lists the capacitance for the various RCM 3400 1/O ports.

Table A-2. Capacitance of Rabbit 3000 I/O Ports

Input Output
I/0 Ports Capacitance Capacitance
(PF) (PF)
Parallel Ports A to G 12 14

Table A-3 liststhe external capacitive busloading for the various RCM 3400 output ports.
Be sure to add the loads for the devices you are using in your custom system and verify
that they do not exceed the valuesin Table A-3.

Table A-3. External Capacitive Bus Loading -40°C to +85°C

Output Port Clock Speed Maximum External
P (MHz) Capacitive Loading (pF)

All 1/O lines with clock
doubler enabled 294 70

All 1/O lines with clock
doubler disabled 14.7456 100

Table A-4 lists the loadings for the A/D converter inputs.

Table A-4. A/D Converter Inputs

Parameter Value

Input Capacitance 4-9.7 pF

Common-Mode 6 MQ

Inpuit Impedance Differential 7 MQ
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Figure A-4 shows atypical timing diagram for the Rabbit 3000 microprocessor external
memory read and write cycles.

External I/0 Read (no extra wait states)
k1 | Tw—s—— T2 |
CLK —
A[15:0] X valid @
D Tadr
/CSx _| \__
] TCSx TCSx R
/IOCSx K -
<1 Tiocsx Tiocsx|<™]
/IORD —
< TiorRD TiorRD[<—1
/BUFEN -
“1TBUFEN TBUFI;ZN‘—>
setup, <]
D[7:0] < NG
| Thotd "
External I/0O Write (no extra wait states)
T | Tw—] T2 ——
CLK —‘ ‘ ‘
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N Tadr ‘
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/CSx _| \ N
<1 Tosx } Tesx|
/IOCSx ! C
<1 Tiocsx { Tiocsx
/IOWR |
Tiowr Tiowr
/BUFEN ’_
1 TBUFEN TBUFEN
D[7:0] valid —
ToHzv | TovhzI<—

Figure A-4. 1/0 Read and Write Cycles—No Extra Wait States

NOTE: /IOCSx can be programmed to be active low (default) or active high.
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Table A-5 lists the delays in gross memory access time for several values of Vpp.

Table A-5. Data and Clock Delays Vpp £10%, Temp, -40°C—+85°C (maximum)

Clock to Address Output Delay Spectrum Spreader Delay
(ns) Data Setup (ns)
VDD Time Delay
T eOE SOE (ns) Normal Strong
g g g dbl/no dbl | dbl/no dbl
3.3 6 8 11 1 3/4.5 4.5/9
2.8 7 10 13 15 3.5/5.5 5.5/11

The measurements are taken at the 50% points under the following conditions.
* T=-40°Cto 85°C,V =Vpp £10%

* Interna clock to nonloaded CLK pindelay < 1 ns @ 85°C/3.0 V

The clock to address output delays are similar, and apply to the following delays.
* Tagr the clock to address delay

* Tcsy theclock to memory chip select delay

* T,ocsx the clock to 1/0 chip select delay

* T,orp, theclock to 1/O read strobe delay

* T,owr theclock to I/O write strobe delay

* Tguren, the clock to 1/0 buffer enable delay

The data setup time delays are similar for both Teep and T g-

When the spectrum spreader is enabled with the clock doubler, every other clock cycleis
shortened (sometimes lengthened) by a maximum amount given in the table above. The
shortening takes place by shortening the high part of the clock. If the doubler is not
enabled, then every clock is shortened during the low part of the clock period. The maxi-
mum shortening for apair of clocks combined is shown in the table.

Technical Note TN227, I nterfacing External 1/0 with Rabbit 2000/3000 Designs, con-
tains suggestions for interfacing I/0 devices to the Rabbit 3000 microprocessors.
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A.3 Rabbit 3000 DC Characteristics

Table A-6. Rabbit 3000 Absolute Maximum Ratings

Symbol Parameter Maximum Rating
Ta Operating Temperature -55° to +85°C
Ts | Storage Temperature -65° to +150°C

Maximum Input Voltage:

* Oscillator Buffer Input Vpp +05V

* 5-V-tolerant 1/0O 55V
Vpp | Maximum Operating Voltage 36V

Stresses beyond those listed in Table A-6 may cause permanent damage. The ratings are
stress ratings only, and functional operation of the Rabbit 3000 chip at these or any other
conditions beyond those indicated in this section is not implied. Exposure to the absolute
maximum rating conditions for extended periods may affect the reliability of the Rabbit
3000 chip.

Table A-7 outlines the DC characteristics for the Rabbit 3000 at 3.3 V over the recom-
mended operating temperature range from T, = -55°C to +85°C, V5 = 3.0V t0 3.6 V.

Table A-7. 3.3 Volt DC Characteristics

Symbol Parameter Test Conditions Min Typ | Max | Units
Vpop | Supply Voltage 3.0 33 3.6 \%
Viy | High-Level Input Voltage 20 \%
ViL | Low-Level Input Voltage 0.8 \Y,

_ loy = 6.8MA, 0.7 x
\ High-Level Output Voltage . \Y,
o J P % | Vpp = Vpp (min) Vbp
v Low-Level Output Volt lo =08 mA, 04 | V
ow-Level Ou oltage : .
o P % | Vpp = Vpp (min)
| High-Level Input Current | ViN = Vpb: 10 A
'H | (absolute worst case, all buffers) | Vpp = Vpp (Max) K
| Low-Level Input Current | Vin = Vss, 10 A
IL | (absolute worst case, all buffers) | Vpp = Vpp (Max) K
High-Impedance State V)N = Vpp O Vs,
loz Output Current Vip = Vpp (Max), no pull-u -10 10 HA
(absolute worst case, all buffers) | * PP~ VDD » MO puli-up
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A.4 1/0 Buffer Sourcing and Sinking Limit

Unless otherwise specified, the Rabbit 1/0 buffers are capable of sourcing and sinking
6.8 mA of current per pin at full AC switching speed. Full AC switching assumes a
29.4 MHz CPU clock and capacitive loading on address and data lines of less than 70 pF
per pin. The absolute maximum operating voltageon al 1/Ois5.5 V.

Table A-8 shows the AC and DC output drive limits of the parallel 1/0 buffers when the
Rabbit 3000 is used in the RCM 3400.

Table A-8. I/0 Buffer Sourcing and Sinking Capability

Output Drive (Full AC Switching)
Sourcing/Sinking Limits

Pin Name (MA)
Sourcing Sinking
All data, address, and 1/0O
lines with clock doubler 6.8 6.8
enabled

Under certain conditions, the maximum instantaneous AC/DC sourcing or sinking current
may be greater than the limits outlined in Table A-8. The maximum AC/DC sourcing cur-
rent can be as high as 12.5 mA per buffer aslong as the number of sourcing buffers does
not exceed three per Vpp or V gg pad, or up to six outputs between pads. Similarly, the
maximum AC/DC sinking current can be as high as 8.5 mA per buffer aslong as the num-
ber of sinking buffers does not exceed three per Vpp or Vgg pad, or up to six outputs
between pads. The Vpp bus can handle up to 35 mA, and the V gg bus can handle up to
28 mA. All these analyses were measured at 100°C.
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A.5 Conformal Coating

The areas around the 32 kHz real-time clock crystal oscillator have had the Dow Corning
silicone-based 1-2620 conformal coating applied. The conformally coated areais shown
in Figure A-5. The conformal coating protects these high-impedance circuits from the
effects of moisture and contaminants over time.
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Figure A-5. RCM3400 Areas Receiving Conformal Coating

Any componentsin the conformally coated areamay be replaced using standard soldering
procedures for surface-mounted components. A new conformal coating should then be
applied to offer continuing protection against the effects of moisture and contaminants.

NOTE: For more information on conformal coatings, refer to Technical Note 303, Con-
formal Coatings.
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A.6 Jumper Configurations

Figure A-6 shows the header locations used to configure the various RCM 3400 options
viajumpers.

Top Side |:|JP3

. JP1
[ ] JP2

Figure A-6. Location of RCM3400 Configurable Positions

Table A-9 lists the configuration options.
Table A-9. RCM3400 Jumper Configurations

Header Description Pins Connected eeltely
Default
1-2 | 128K/256K RCM3410
JP1 | Flash Memory Size
2-3 | 512K RCM 3400
1-2 | 128K/256K RCM 3410
JP2 | SRAM Size
2-3 | 512K RCM 3400
1-2 | Normal Mode X
JP3 | Flash Memory Bank Select
2-3 | Bank Mode

NOTE: The jumper connections are made using 0 Q surface-mounted resistors.
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APPENDIX B. PROTOTYPING BOARD

Appendix B describes the features and accessories of the Proto-
typing Board, and explains the use of the Prototyping Board to
demonstrate the RCM 3400 and to build prototypes of your own
circuits.
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B.1 Introduction

The Prototyping Board included in the Development Kit makes it easy to connect an
RCM 3400 module to a power supply and a PC workstation for development. It also pro-
vides some basic I/0 peripherals (RS-232, RS-485, an IrDA transceiver, an Ethernet port,
LEDs, and switches), as well as a prototyping area for more advanced hardware devel op-

ment.

For the most basic level of evaluation and development, the Prototyping Board can be
used without modification.

Asyou progress to more sophisticated experimentation and hardware development, modi-
fications and additions can be made to the board without modifying or damaging the
RCM 3400 module itself.

The Prototyping Board is shown below in Figure B-1, with its main features identified.
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Figure B-1. Prototyping Board
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B.1.1 Prototyping Board Features

Power Connection—A power-supply jack and a 3-pin header are provided for con-
nection to the power supply. Note that the 3-pin header is symmetrical, with both outer
pins connected to ground and the center pin connected to the raw V+ input. The cable
of the AC adapter provided with the North American version of the Development Kit
endsin a plug that connects to the power-supply jack. The header plug leading to bare
leads provided for overseas customers can be connected to the 3-pin header in either
orientation.

Users providing their own power supply should ensure that it delivers 8-24 V DC at
1 A. Thevoltage regulators will get warm whilein use.

Regulated Power Supply—Theraw DC voltage provided at the POWER IN jack is
routed to a5 V switching voltage regulator, then to a separate 3.3 V linear regulator.
The regulators provide stable power to the RCM 3400 module and the Prototyping
Board.

Power LED—The power LED lights whenever power is connected to the Prototyping
Board.

Reset Switch—A momentary-contact, normally open switch is connected directly to the
RCM3400's/RESET _IN pin. Pressing the switch forces a hardware reset of the system.

Programming Header—T he programming cableis used to connect the RCM 3400 via
the programming header on the Prototyping Board to your PC to enable you to program
your RCM 3400 module.

I/O Switches and LEDs—Two momentary-contact, normally open switches are con-
nected to the PD4 and PD5 pins of the RCM 3400 module and may be read as inputs by
sample applications.

Two LEDs are connected to the PD6 and PD7 pins of the RCM 3400 module, and may
be driven as output indicators by sample applications.

Prototyping Area—A generous prototyping area has been provided for theinstallation
of through-hole components. +3.3 V, +5 V, and Ground buses run around the edge of
thisarea. Severa areas for surface-mount devices are also available. (Note that there
are SMT device pads on both top and bottom of the Prototyping Board.) Each SMT pad
is connected to a hole designed to accept a 30 AWG solid wire.

Module Extension Headers—The complete non-analog pin set of the RCM 3400
module is duplicated at header J1. Developers can solder wires directly into the appro-
priate holes, or, for more flexible development, a2 x 30 header strip with a0.1" pitch
can be soldered into place. See Figure B-4 for the header pinouts.

Analog Inputs Screw-Terminal Header—The complete analog pin set of the
RCM 3400 module is duplicated at screw-terminal header J3. See Figure B-4 for the
header pinouts.
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RS-232—Two 3-wire or one 5-wire RS-232 serial ports are available on the Prototyp-
ing Board at header J5 and another two 3-wire or one 5-wire RS-232 serial ports are
available at header J6.

A 10-pin 0.1-inch spacing header strip isinstalled at J5 allows you to connect a ribbon
cable that leadsto a standard DE-9 seria connector.

NOTE: AnRS-232 driver chip needsto beinstalled at U5 along with a header at J6 and
filtering capacitors in order to use header J6.

Current Measurement Option—Jumpers across pins 1-2 and 5-6 on header JP10 can
be removed and replaced with an ammeter across the pins to measure the current drawn
from the +5V or the +3.3 V supplies, respectively.

LCD/Keypad Module—Z-World's LCD/keypad module may be plugged in directly to
headers LCD1JA, LCD1JB, and LCD1JC. Appendix D provides complete information
for mounting and using the LCD/keypad module.
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B.2 Mechanical Dimensions and Layout
Figure B-2 shows the mechanical dimensions and layout for the RCM 3400 Prototyping Board.
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Figure B-2. Prototyping Board Dimensions
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Table B-1 lists the electrical, mechanical, and environmental specifications for the Proto-

typing Board.
Table B-1. Prototyping Board Specifications
Parameter Specification
Board Size 4.80" x 6.70" x 0.98" (122 mm x 170 mm X 25 mm)

Operating Temperature

—20°Cto +60°C

Humidity

5% to 95%, honcondensing

Input Voltage

8Vto24Vv DC

Maximum Current Draw
(including user-added circuits)

800 mA max. for +3.3 V supply,
1A total +3.3V and +5 V combined

Prototyping Area

2" x 4" (50 mm x 100 mm) throughhole, 0.1" spacing,

additional space for SMT components

Standoffs/Spacers

6, accept 4-40 x Y5 screws

B.3 Power Supply

The RCM3400 requires aregulated 2.8 V — 3.45 V DC power source to operate. Depend-
ing on the amount of current required by the application, different regulators can be used
to supply this voltage.

The Prototyping Board has an onboard +5 V switching power regulator from which a
+3.3 V linear regulator drawsits supply. Thus both +5V and +3.3 V are available on the
Prototyping Board.

The Prototyping Board itself is protected against reverse polarity by a Shottky diode at D2
as shown in Figure B-3.

LINEAR POWER
L8116 SWITCHING POWER REGULATOR ~ +5V RECLLATER a0y
x | LM1117
u, 2 | +raw P2 DCIN T a[ U0 |
2 P ut2

e b DLa003 | CB 1
& 10 WF 1 10 uF

47 uF u T u

= 1: LM2575 & D1 L1 l = il
= L 4 Nss19

Figure B-3. Prototyping Board Power Supply
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B.4 Using the Prototyping Board

The Prototyping Board is actually both a demonstration board and a prototyping board.
Asademonstration board, it can be used to demonstrate the functionality of the RCM 3400
right out of the box without any modifications to either board.

The Prototyping Board comes with the basic components necessary to demonstrate the
operation of the RCM3400. Two LEDs (DS1 and DS2) are connected to PD6 and PD7,
and two switches (S2 and S3) are connected to PD4 and PD5 to demonstrate the interface
to the Rabbit 3000 microprocessor. Reset switch Sl isthe hardware reset for the RCM 3400.

The Prototyping Board provides the user with RCM 3400 connection points brought out con-
veniently to labeled points at header J1 and J3 on the Prototyping Board. Although header J1
is unstuffed, a2 x 30 header isincluded in the bag of parts. RS-485 signals are available on
header M4, and RS-232 signals are available on header J5 (Seria Ports C and D) and header
J6 (Serial PortsE and F). A header strip at J5 alows you to connect aribbon cable, anda2 x 5
header isincluded in the bag of parts for optiona installation at J6. The pinouts for these
locations are shown in Figure B-4.

GND
RxD
TxD

J4060

RS-232

o

-~
o
(3]

GND
TXE RxC

OO0

ole
TxF OO|RXxE  TxC
RxF OO

re1|Q Q| rs2 J6

RS-232
pe3|Q Q| Ps4 - O

RCM3400 pos[Q OfPos
Non-Analog ro7|Q Q| Peo
Signals re1|Q Q| Pe2

rc2|Q Q) Pas
pa4|Q Q| Pes
res|OQ Q| Pa7
Res ouT|Q O ReseT IN
+33v|Q Q| eno
veatT[Q QO +33v

aND|O) Ol eno

J3 [SB0000000000)

mmmmmmmmmmmm
zzzzzzzzzzzz

oooooooo
<< < << <y

=

ANALOG_GI

Analog
Inputs

Figure B-4. Prototyping Board Pinout

User’s Manual 59



Thereisa?2" x 4" through-hole prototyping space available on the Prototyping Board. The
holesin the prototyping area are spaced at 0.1" (2.5 mm). +3.3V, +5V, and GND tracesrun
aong the edge of the Prototyping Board for easy access. Small to medium circuits can be
prototyped using point-to-point wiring with 20 to 30 AWG wire between the prototyping
area, the +3.3V, +5V, and GND traces, and the surrounding area where surface-mount
components may be installed. Small holes are provided around the surface-mounted com-
ponents that may be installed around the prototyping area.

B.4.1 Adding Other Components

There are two sets of pads for 28-pin devices that can be used for surface-mount prototyp-
ing involving SOIC devices.There are also pads that can be used for SMT resistors and
capacitorsin an 0805 SMT package. Each component has every one of its pin pads con-
nected to ahole in which a30 AWG wire can be soldered (standard wire wrap wire can be
soldered in for point-to-point wiring on the Prototyping Board). Because the traces are
very thin, carefully determine which set of holesis connected to which surface-mount pad.

B.4.2 Measuring Current Draw

The Prototyping Board has a current-measurement feature available on header JP10. Nor-
mally, ajumper connects pins 1-2 and pins 5-6 on header JP10, which provide jumper
connectionsfor the +5 V and the +3.3 V regulated voltages respectively. You may remove
ajumper and place an ammeter across the pins instead, as shown in the example in
Figure B-5, to measure the current being drawn.

MEASUREMENT

CURRENT
OPTION

JPO

i

Figure B-5. Prototyping Board Current-Measurement Option
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B.4.3 Analog Features

The Prototyping Board has typical support circuitry installed to complement the ADS7870
A/D converter on the RCM 3400 module.

B.4.3.1 A/D Converter Inputs

Figure B-6 shows a pair of A/D converter input circuits. The resistors form an approx.
10:1 attenuator, and the capacitor filters noise pulses from the A/D converter input.

+V

178 kQ
ADC_INO

NV
? ADC_IN1 A

178 kQ

1nE1nE[

ADC

20 kQ
20 kQ

2

JP1 -
BVREF =
S > 2048V

0Q

AGND Faétory
Default

I

Figure B-6. A/D Converter Inputs

The A/D converter chip can make either single-ended or differential measurements
depending on the value of the opnode parameter in the software function call. Adjacent
A/D converter inputs are paired to make differential measurements. The default setup on
the Prototyping Board isto measure only positive voltages for the rangeslisted in Table B-2.

Table B-2. Positive A/D Converter Input Voltage Ranges

Min. X/o)ltage Max.(\\//(;ltage AI’?}F:;:GF MV per Tick
0.0 +20.0 1 10
0.0 +10.0 2 5
0.0 +5.0 4 25
0.0 +4.0 5 2.0
0.0 +2.5 8 1.25
0.0 +2.0 10 10
0.0 +1.25 16 0.625
0.0 +1.0 20 0.500
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Many other possible ranges are possible by physically changing the resistor values that
make up the attenuator circuit.

It isalso possible to read a negative voltage on ADC_INO-ADC_IN5 by moving the 0 Q
jumper (see Figure B-6) on header JP1, JP2, or JP9 associated with the A/D converter
input from analog ground to the reference voltage generated and buffered by the A/D con-
verter. Adjacent input channels are paired so that moving a particular jumper changes both
of the paired channels. At the present time Z-World does not offer the software driversto
work with single-ended negative voltages, but the differential mode described below may
be used to measure negative voltages.

NOTE: THERM_IN7 was configured to illustrate the use of athermistor with the sample
program, and so is not available for use as a differentia input. There is also no resistor
attenuator for THERM _IN7, so itsinput voltage rangeis limited.

Differential measurements require two channels. As the name differential implies, the dif-
ference in voltage between the two adjacent channelsis measured rather than the differ-
ence between the input and analog ground. Voltage measurements taken in differential
mode have aresolution of 12 bits, with the 12th bit indicating whether the differenceis
positive or negative.

The A/D converter chip can only accept positive voltages, as explained in Section 4.3. Both
differentia inputs must be referenced to analog ground, and both inputs must be positive
with respect to analog ground. Table B-3 provides the differential voltage ranges for this
setup.

Table B-3. Differential Voltage Ranges

Min. Differential | Max. Differential Amplifier _
Voltage Voltage _ mV per Tick

V) ) Gain

0 +20.0 x1 10

0 +10.0 x2 5

0 5.0 x4 25

0 4.0 x5 20

0 125 x8 125
0 2.0 x10 1.00
0 +1.25 x16 0.625
0 +1.0 x20 0.500

The A/D converter inputs can a so be used with 4-20 mA current sources by measuring the
resulting analog voltage drop across 249 Q 1% precision resistors placed between the ana-
log input and analog ground for ADC_IN3 to ADC_ING6. Be sure to reconfigure the
jumper positions on header JP5 as shown in Section B.5 using the slip-on jumpers
included with the spare parts in the Devel opment Kit.
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B.4.3.2 Thermistor Input

Anaog input THERM_IN7 on the Prototyping Board was designed specifically for use
with athermistor in conjunction with the THERM STOR. C sample program, which demon-
strates how to use analog input THERM _IN7 to calculate temperature for display to the
Dynamic C STDIO window. The sample program istargeted specifically for the thermistor
included with the Development Kit with Ry @ 25°C = 3 kQ and 3 25/85 = 3965. Be sure

to use the applicable Ry and 3 values for your thermistor if you use another thermistor.

BVREF

1kQ

Thermistor J3
9

a

THERM_IN7 ® ADC

ANALOG_GND

= R

200

Figure B-7. Prototyping Board Thermistor Input

B.4.3.3 A/D Converter Calibration

To get the best results form the A/D converter, it is necessary to calibrate each mode (sin-
gle-ended, differential, and current) for each of itsgains. It isimperative that you calibrate
each of the A/D converter inputs in the same manner as they are to be used in the applica-
tion. For example, if you will be performing floating differential measurements or differ-
ential measurements using a common analog ground, then calibrate the A/D converter in
the corresponding manner. The calibration must be done with the attenuator reference
selection jJumper in the desired position (see Figure B-6). If acalibration is performed and
the jumper is subsequently moved, the corresponding input(s) must be recalibrated. The
calibration table in software only holds calibration constants based on mode, channel, and
gain. Other factors affecting the calibration must be taken into account by calibrating
using the same mode and gain setup asin the intended use.

Sample programs are provided to illustrate how to read and calibrate the various A/D
inputs for the three operating modes.

Mode Read Calibrate
Single-Ended, one channel — AD CAL_CHAN. C
Single-Ended, all channels AD RDVOLT ALL.C AD CAL ALL.C
Milli-Amp, one channel AD RDVA CH. C AD CALNMA CH. C
Differential, analog ground AD RDDI FF_CH. C AD CALDI FF_CH. C

These sample programs are found in the ADC subdirectory in SAMPLES\ RCMB400. See
Section B.6.2 for more information on these sample programs and how to use them.
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B.4.4 Serial Communication

The RCM 3400 Prototyping Board allows you to accessfive of the seria ports from the
RCM 3400 module. Table B-4 summarizes the configuration options.

Table B-4. RCM3400 Prototyping Board Serial Port Configurations

Serial Port Header Default Use Alternate Use
A J2 Programming Port RS-232
C J5 RS-232 —
D J5 RS-232 —
E 4, J6 RS-485 (M) RS-232 (J6)
F IrDA, J6 IrDA Transceiver RS-232 (J6)

Serial Port E is configured in hardware for RS-232 or RS-485 via jumpers on headers JP4
and JP8 as shown in Section B.5. Serial Port F is configured in hardware for the IrDA
transceiver or RS-232 via jumpers on headers JP6 and JP7 as shown in Section B.5.
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B.4.4.1 RS-232

RS-232 serial communication on header J5 on the the RCM 3400 Prototyping Board is
supported by an RS-232 transceiver installed at U4. This transceiver provides the voltage
output, slew rate, and input voltage immunity required to meet the RS-232 serial commu-
nication protocol. Basically, the chip trandates the Rabbit 3000's signalsto RS-232 signal
levels. Note that the polarity is reversed in an RS-232 circuit so that a+5 V output
becomes approximately -10 V and 0 V isoutput as+10 V. The RS-232 transceiver also
provides the proper line loading for reliable communication.

A customer-supplied RS-232 transceiver may be installed at U5, and a2 x 5 header from
the bag of partsin the Development Kit may beinstalled at J6 to access Serial PortsE and F,
which are by default configured for RS-485 and IrDA support on the Prototyping Board as
explained above. Be sure to configure the 0 Q jumpers as explained in Section B.5 to be
able to access Seria Ports E and F on header J6.

RS-232 can be used effectively at the RCM 3400 module' s maximum baud rate for distances
of upto15m.

RS-232 flow control on an RS-232 port isinitiated in software using the ser Xf | owcon-
t r ol On function call from RS232. LI B, where X isthe serial port (C or D). The locations
of the flow control lines are specified using a set of five macros.

SERX_RTS PORT—Dataregister for the parallel port that the RTS lineis on (e.g., PCDR).

SERA RTS_SHADOW—Shadow register for the RTS line's parallel port (e.g., PCDRShadow).
SERA RTS_ BI T—The bit number for the RTS line.

SERA CTS PORT—Dataregister for the parallel port that the CTS line is on (e.g., PCDRShadow).
SERA CTS Bl T—The bit number for the CTSline.

Standard 3-wire RS-232 communication using Serial Ports C and D isillustrated in the
following sample code.

#define CI NBUFSI ZE 15
#def i ne COUTBUFSI ZE 15

#define DI NBUFSI ZE 15
#def i ne DOUTBUFSI ZE 15

#i f ndef _232BAUD
#define _232BAUD 115200
#endi f

mai n() {
ser Copen(_232BAUD) ;
ser Dopen(_232BAUD) ;
ser Ow Fl ush();
ser Cr dFl ush();
ser Dwr Fl ush();
ser Dr dFl ush();
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B.4.4.2 RS-485

The RCM 3400 Prototyping Board has one RS-485 serial channel, which is connected to
the Rabbit 3000 Serial Port E through an RS-485 transceiver. The half-duplex communi-
cation uses an output from PDO on the Rabbit 3000 to control the transmit enable on the
communication line. Using this scheme a strict master/slave relationship must exist
between devices to insure that no two devices attempt to drive the bus simultaneoudly.

Serial Port E is configured in software for RS-485 as follows.

#defi ne ser485open ser Eopen

#def i ne ser485cl ose ser Ecl ose
#def i ne ser485w Fl ush ser Ewr Fl ush
#def i ne ser485r dFl ush ser ErdFl ush
#defi ne ser485putc serEputc

#def i ne ser485getc serEgetc

#def i ne EI NBUFSI ZE 15
#def i ne EQUTBUFSI ZE 15

#i f ndef _485BAUD
#define _485BAUD 115200
#endi f
The configuration shown above is based on circular buffers. RS-485 configuration may
aso be done using functions from the PACKET. LI B library.

The RCM 3400 Prototyping Boards with RCM 3400 modules installed can be used in an
RS-485 multidrop network spanning up to 1200 m (4000 ft), and there can be as many as
32 attached devices. Connect the 485+ to 485+ and 485— to 485— using single twisted-pair
wires as shown in Figure B-8. Note that a common ground is recommended.

——

RS-485—
RS485+
GND
RS-485- I~
RS485+ [~
GND [—

Figure B-8. RCM3400 Multidrop Network
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The RCM 3400 Prototyping Board comes with a 220 Q termination resistor and two 681 Q
bias resistors installed and enabled with jumpers across pins 1-2 and 5-6 on header JP3,

as shown in Figure B-9.

Factory

Default

c@%] ] g8
“C3 e
oo o o o ¢

—
" Wlmcar
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T
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9420 mA

o
220 Q gooooooooo 000000

0000000000000
NQ_O_O_O_O_O_O_Qooooo

OOOOOOOOOOOOOOOOOOOOOOOOOOO
0000000000000 00000000000
OOOOOOOOOOOOOOOOOOOOOOOOOOO

OOOOOOOOOO

RCM3400

. 550006006609 0 s=f

OOOOOOOOOO
0 Q0O 0

ING AINT AINZ AING AINA AIN5 ANG THERI

NURTVREF

Figure B-9. RS-485 Termination and Bias Resistors

For best performance, the termination resistorsin a multidrop network should be enabled
only on the end nodes of the network, but not on the intervening nodes. Jumpers on boards

whose termination resistors are not enabled may be stored across pins 1-3 and 46 of

header JP3.
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B.4.4.3 Ethernet Port

Figure B-10 showsthe pinout for the Ethernet port (header J7). Note that there are two stan-
dards for numbering the pins on this connector—the convention used here, and numbering
in reverse to that shown. Regardless of the numbering convention followed, the pin posi-
tionsrelative to the spring tab position (located at the bottom of the RJ-45 jack in

Figure B-10) are always absolute, and the RJ-45 connector will work properly with off-
the-shelf Ethernet cables.

ETHERNET

1[%&3
1. E_Tx+
2. E_Tx-

3. E_Rx+
6. E_Rx—

RJ-45 Plug RJ-45 Jack

Figure B-10. RJ-45 Ethernet Port Pinout

RJ-45 pinouts are sometimes numbered opposite to the way shown in Figure B-10.

Two LEDs are placed next to the RJ45 Ethernet jack, one to indicate a live Ethernet link
(LNK) and one to indicate Ethernet activity (ACT).

The transformer/connector assembly ground is connected to the RCM 3400 Prototyping
Board printed circuit board digital ground viaa 0 Q resistor “jumper,” R46, as shown in
Figure B-11.

RJ-45 Ethernet Plug

R46

Board Chassis
Ground = = Ground

Figure B-11. Isolation Resistor R46

The factory default isfor the 0 Q resistor “jumper” at R46 to be installed. In high-noise
environments, remove R46 and ground the transformer/connector assembly directly to
ground by soldering a wire between the RJ-45 transformer/connector assembly and
ground. Thiswill be especialy helpful to minimize ESD and/or EMI problems.
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B.4.5 Other Prototyping Board Modules

An optional LCD/keypad module is available that can be mounted on the Prototyping
Board. Refer to Appendix D, “LCD/Keypad Module,” for complete information.
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B.5 RCM3400 Prototyping Board Jumper Configurations

Figure B-12 shows the header locations used to configure the various RCM 3400 Prototyp-
ing Board options viajumpers.

JP10
JP3 Battery 50
&
elele) I O
u JP8
] JP4
Note
" JPe JP6 and JP7 are located
" JP7  under the RCM3400
(if the RCM3400 module
Is plugged in)
JP5
olelele
[ T T ]
n | u
JP1 JP2 JP9

Figure B-12. Location of RCM3400 Configurable Positions

Table B-5 lists the configuration options using either jumpers or 0 Q surface-mount resistors.

Table B-5. RCM3400 Jumper Configurations

Header Description Pins Connected Factory
Default

1-2 | Tied to BVREF

J1 | ADC_INO-ADC_IN1
2-3 | Tied to analog ground X

1-2 | Tied to BVREF

J2 | ADC_IN2-ADC_IN3
2-3 | Tied to analog ground X
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Table B-5. RCM3400 Jumper Configurations (continued)

Header Description Pins Connected oo
Default

1-2 |Biasand termination resistors X

5-6 | connected
I3 RS-485 Bias and Termination

Resistors 1-3 Bias and termination resistors not
connected (parking position for
46 |.
jumpers)

1-2 |RS485 X
JP4" | PG7 RS-232/RS-485 Select

2-3 |RS-232 (RxE)

1-2 | Connect for 4-20mA gptionon ADC _IN3 n.c.
5 Analog Voltage/4-20 mA 3—4 | Connect for 4-20mA optionon ADC_IN4 n.c.

Options 5-6 | Connect for 4-20mA opiononADC_INS | n.c.

7-8 | Connect for 4-20mA optionon ADC_IN6 n.c.

1-2 |IrDA X
Jre" | PG3IrDA/RS-232 Select

2-3 |RS-232 (RxF)

1-2 | IrDA X
JP7" | PG2IrDA/RS-232 Select

2-3 |RS-232 (TxF)

1-2 | RS-485 X
JP8" | PG6 RS-232/RS-485 Select

2-3 |RS-232 (TXE)

1-2 | Tied to BVREF
JP9" | ADC_IN4-ADC IN5

2-3 | Tied to analog ground X

1-2 |+5V Connected
JP10 | Current Measurement Option

56 [+33V Connected

*  These jJumper connections are made using 0 Q surface-mounted resistors.

User’s Manual

71



B.6 Sample Programs

Sample programs illustrating serial communication and the A/D converter with the Proto-
typing Board are provided in the SAMPLES\ RCMB400 directory. Other sample programs
related directly to the RCM 3400 and TCP/IP are described in Appendix C. Each sample
program has comments that describe the purpose and function of the program. Follow the
instructions at the beginning of the sample program.

To run asample program, open it with the File menu (if it isnot still open), compileit using
the Compile menu, and then run it by selecting Run inthe Run menu. The RCM3400
must bein Program mode (see Section 3.3, “Programming Cable), and must be connected
to a PC using the programming cable as described in Chapter 2, “ Getting Started.”

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

B.6.1 Serial Communication

The following sample programs are found in the SERI AL subdirectory in
SAMPLES\ RCV3400.

e FLOWCONTROL. CG—This program demonstrates how to configure Serial Port C for
CTS/RTS with serial data coming from Serial Port D. The serial datareceived are dis-
played in the STDIO window.

* PARI TY. C—This program demonstrates the use of parity modes by repeatedly sending
byte values 0—127 from Serial Port D to Serial Port C. The program will switch
between generating parity or not on Serial Port D. Serial Port C will always be check-
ing parity, so parity errors should occur during every other sequence.

e S| MPLE3W RE. C—This program demonstrates basic RS-232 serial communication.
e S| MPLESW RE. C—This program demonstrates 5-wire RS-232 serial communication.

e SW TCHCHAR. C—This program demonstrates transmits and then receives an ASCI|
string on Serial Ports D and C. It also displays the serial data received from both ports
in the STDIO window.

e S| MPLE485MASTER. C—This program demonstrates a simple RS-485 transmission of
lower case |etters to a slave RCM3400. The slave will send back converted upper case
letters back to the master RCM 3400 and display them in the STDIO window. Use
S| MPLE485SLAVE. Cto program the slave RCM 3400.

* S| MPLE485LAVE. C—This program demonstrates a simple RS-485 transmission of
lower caselettersto amaster RCM 3400. The slave will send back converted upper case
letters back to the master RCM 3400 and display them in the STDIO window. Use
SI MPLE485MASTER. C to program the masterRCM 3400.
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B.6.2 A/D Converter Inputs
The following sample programs are found in the ADC subdirectory in SAMPLES\ RCVB400.

e AD CAL_ALL. C—Demonstrates how to recalibrate all single-ended analog input chan-
nels for one gain, using two known voltages to generate the calibration constants for
each channel. Constants will be rewritten into the user block data area.

e AD_CAL_CHAN. C—Demonstrates how to recalibrate one single-ended analog input
channel with one gain using two known voltages to generate the calibration constants
for that channel. Constants will be rewritten into user block data area.

* AD _CAL_DI FF. C—Demonstrates how to recalibrate one differential analog input
channel using two known voltages to generate the calibration constants for that channel.
Constants will be rewritten into user block data area.

* AD CALMA CH. C—Demonstrates how to recalibrate an A/D input channel being used to
convert analog current measurements to generate the calibration constants for that channel.

NOTE: The above sample programswill overwrite any existing calibration constants.

* AD_RDDI FF_CH. G—Demonstrates how to read an A/D input channel being used for a
differential input using previously defined calibration constants.

* AD_RDMA CH. G—Demonstrates how to read an A/D input channel being used to con-
vert analog current measurements using previously defined calibration constants for
that channel.

* AD RDVOLT_ALL. G—Demonstrates how to read all single-ended A/D input channels
using previously defined calibration constants.

e AD_SAMPLE. C—Demonstrates how to use alow-level driver on single-ended inputs.
The program will continuously display the voltage (average of 10 samples) that is
present on the A/D channels.

e ANAI NCONFI G. C—Demonstrates how to use the Register Mode method to read single-
ended analog input values for display as voltages. The sample program uses the func-
tion call anal nConfi g() and the ADS7870 CONVERT line to accomplish this task.

e THERM STOR. C—Demonstrates how to use analog input THERM _IN7 to calculate
temperature for display to the STDIO window. This sample program assumes that the
thermistor is the one included in the Development Kit whose values for beta, series
resistance, and resistance at standard temperature are given in the part specification.

* DNLOADCALI B. C—Demonstrates how to retrieve analog calibration data to rewrite it
back to simulated EEPROM in flash with using a seria utility such as Tera Term.

* UPLOADCALI B. C—Demonstrates how to read calibrations constants from the user
block in flash memory and then transmitting the file using a serial port and a PC seridl
utility such as Tera Term. Use DNLOADCAL| B. Cto download the calibration constants
created by this program.
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B.7 Software Function Calls

Although the software function calls described in this section were prepared specifically

for the RCM 3400 Prototyping Board with an RCM 3400 series module attached, the func-
tion callsillustrate how you can develop your own applications around the RCM 3400. The
function callsarein the RCM34XX. LI Blibrary in the Dynmaic C LI B\ RCM3400 directory.

B.7.1 Board Initialization

void brdinit (void);

Call this function at the beginning of your program. This function initializes Parallel Ports A through G
for use with the RCM 3400 Prototyping Board.

Summary of Initialization
1. Display/keypad select is disabled.
2. Ethernet select is disabled.
3. RS-485 is not enabled.
4. RS-232 isnot enabled.
5. Unused configurable /O are tied inputs or outputs set low.
6. A/D converter isreset and SCLKB is set to 57,600 bps.
7.A/D converter calibration constants are read, so this function cannot run in RAM.

RETURN VALUE
None.
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B.7.2 Analog Inputs

unsi gned i nt anal nConfi g(unsi gned i nt
i nstructionbyte, unsigned int cnd, |ong baud);

Use this function to configure the ADS7870 A/D converter. This function will address the ADS7870 in
Register Mode only, and will return error if you try the Direct Mode. Appendix provides additional
addressing and command information.

ADS7870 Signal | ADS7870 State RCM3400 Function/State
LNO Input AINO
LN1 Input AIN1
LN2 Input AIN2
LN3 Input AIN3
LN4 Input AIN4
LN5 Input AIN5
LN6 Input AING
LN7 Input AIN7
/RESET Input Board reset device
RISE/FALL Input Pulled up for SCLK active on rising edge
PIOO I nput Pulled down
PIO1 Input Pulled down
PIO2 Input Pulled down
PIO3 Input Pulled down
CONVERT Input Pulled down
BUSY Output PD1 pulled down; logic high state converter is busy
CCLKCNTRL I nput Pulled down; O state sets CCLK asinput
CCLK Input Pulled down; external conversion clock
SCLK I nput PBO; serial datatransfer clock
SDI Input PC4; 3-wire mode for seria datainput
SDO Output PC5,; serial data output /CSdriven
ICS Input PD2 pulled up; active-low enables serial interface
BUFIN I nput Pulled down; reference buffer amplifier
VREF Output Connected to BUFIN
BUFOUT Output Pulled down
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PARAMETERS
i nst ructi onbyt e istheinstruction byte that will initiate a read or write operation at 8 or 16 bits on

the designated register address. For example,
checki d = anal nConfi g(0x5F, 0, 9600); // read ID and set baud rate

cnd are the command data that configure the registers addressed by the instruction byte. Enter 0 if you
are performing aread operation. For example,
i = anal nConfig(0x07, Ox3b, 0); // wite ref/osc reg and enabl e

baud isthe serial clock transfer rate of 9600 to 57,600 bps. baud must be set the first time this function
iscalled. Enter O for this parameter thereafter, for example,

anal nConfi g(0x00, 0x00, 9600); // resets device and sets baud

RETURN VALUE
0 on write operations,
data value on read operations

SEE ALSO
analnDriver, analn, brdlnit
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unsi gned int anal nDriver (unsigned int cnd,
unsigned int |en);

Reads the voltage of an analog input channel by serial-clocking an 8-bit command to the ADS7870 A/D
converter by the Direct Mode method. This function assumes that Model (most significant bytefirst) and
the A/D converter oscillator have been enabled. See anal nConf i g() for the setup.

The conversion beginsimmediately after the last data bit has been transferred. An exception error will
occur if Direct Mode bit D7 is not set.

PARAMETERS
cnd contains a gain code and a channel code as follows.
D7—1; D6-D4—Gain Code; D3-D0—Channel Code
Use the following cal culation and the tables below to determine cd:
cnmd = 0x80 | (gain_code*16) + channel _code

Gain Code Multiplier

0 x1

1 x2

2 x4

3 x5

4 x8

5 x10

6 x16

7 x20

Channel Code Differi?r:i;[ Input Channel Code SllnnngI:_LEiEZSeg 4—|_2igen;A

0 +AINO -AIN1 8 AINO AINOT
1 +AIN2 -AIN3 9 AIN1 AIN1T
2 +AIN4 -AIN5 10 AIN2 AIN2T
3t +AING -AIN7 11 AIN3 AIN3
4 -AINO +AIN1 12 AIN4 AIN4
-AIN2 +AIN3 13 AINS AINS
6 -AIN4 +AIN5 14 AING6 AING6
vdl -AING6 +AIN7 15 AIN7 AINT7T

* Negative input is ground.
T Not accessible on RCM 3700 Prototyping Board

| en, the output bit length, is always 12 for 11-bit conversions
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RETURN VALUE
A value corresponding to the voltage on the analog input channel:
02047 for 11-bit conversions (bit 12 for sign)

-1 overflow or out of range
-2 conversion incomplete, busy bit timeout

SEE ALSO
anal nConfig, analn, brdlnit
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unsi gned i nt anal n(unsi gned int channel,
i nt opnode, int gai ncode);

Reads the val ue of an analog input channel using the direct method of addressing the ADS7870 A/D
converter.

PARAMETERS
channel isthe channel number (0to 7) corresponding to ADC_INOto ADC_IN7
opnode isthe mode of operation:
SI NGLE—single-ended input
Dl FF—differential input
MAMP—A4-20 mA input

channel SI NGLE Dl FF mANVP
0 +AINO +AINO -AIN1 +AINO
1 +AIN1 +AIN1 -AINO" +AIN1"
2 +AIN2 +AIN2 -AIN3 +AIN2"
3 +AIN3 +AIN3 -AIN2 +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AIN5 -AIN4" +AIN5
6 +AING +AING -AIN7" +AING
7 +AIN7 +AIN7 -AIN6" +AIN7"

* Not accessible on Prototyping Board.

gai ncode isthe gain code of 0to 7 (applies only to Prototyping Board):

Gain Code Multiplier UelEge Renge

V)

0 x1 0-20

1 x2 0-10

2 x4 0-5

3 x5 04

4 x8 0-25

5 x10 0-2

6 x16 0-1.25

7 %20 0-1

RETURN VALUE
A value corresponding to the voltage on the analog input channel:

02047 for 11-bit A/D conversions (signed 12th hit)
ADOVERFL OWM(defined macro = -4096) if overflow or out of range
-4095 if conversion isincomplete or busy-bit timeout

SEE ALSO
anal n, anal nConfig, analnDriver
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int analnCalib(int channel,

i nt gai ncode,
float volts2);

i nt val ue2,

i nt val uel,

i nt opnode,
float vol tsl,

Calibrates the response of the desired A/D converter channel as alinear function using the two conver-
sion points provided. Four values are calculated and placed into global table _adcCal i bX to be later
stored into simulated EEPROM using the function anal nEEW () . Each channel will have alinear con-
stant and a voltage offset.

PARAMETERS

channel istheanalog input channel number (0 to 7) corresponding to ADC_INOto ADC_IN7

opnode isthe mode of operation:

SI NGLE—single-ended input
DI FF—differential input
mMAMP—milliamp input

channel SI NGLE Dl FF mAVP
0 +AINO +AINO -AIN1 +AINO
1 +AIN1 +AIN1 -AINO" +AIN1"
2 +AIN2 +AIN2 -AIN3 +AIN2"
3 +AIN3 +AIN3 -AIN2 +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AIN5 -AIN4" +AIN5
6 +AING +AING -AIN7" +AING
7 +AIN7 +AIN7 -AIN6" +AIN7"

* Not accessible on Prototyping Board.

gai ncode isthegain codeof 0to 7:

Gain Code Multiplier | Voltage Range’

(V)
0 x1 0-20
1 x2 0-10
2 x4 0-5
3 x5 04
4 *8 0-25
3 x10 0-2
6 x16 0-1.25
7 x20 0-1

*  Appliesto RCM 3400 Prototyping Board.

80

RabbitCore RCM3400



val uel isthefirst A/D converter channel value (0—2047)

vol t s1 isthevoltage or current corresponding to the first A/D converter channel value (0to +20 V or
4 t0 20 mA)

val ue?2 isthe second A/D converter channel value (0-2047)

vol t s2 isthevoltage or current corresponding to the first A/D converter channel value (0to +20 V or
4 t0 20 mA)

RETURN VALUE
0if successful.

-1if not able to make calibration constants.

SEE ALSO

anal n, analnVolts, anal nmAnps, analnDiff, anal nSet Range, anal nVol t XGai n,
analnCalib, brdinit
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fl oat anal nVol ts(unsi gned int channel,
unsi gned i nt gai ncode);

Reads the state of a single-ended anal og input channel and uses the previously set calibration constantsto

convert it to volts.

PARAMETERS
channel isthe channel number (0-7):

Channel Code SIangLif_LEizzse? Voltag?VI)?angeT
0 +AINO 0-20
1 +AIN1 0-20
2 +AIN2 0-20
3 +AIN3 0-20
4 +AIN4 0-20
5 +AIN5 0-20
6 +AING 0-20
7 +AIN7 oot

* Negative input is ground.
t Appliesto RCM 3400 Prototyping Board.
¥ Used for thermistor in sample program.

gai ncode isthegain codeof 0to 7.

Gain Code | Multiplier | Voltage Range’

V)

0 x1 0-20

1 x2 0-10

2 x4 0-5

3 x5 04

4 *8 0-25

5 x10 0-2

6 x16 0-1.25

7 x20 0-1

*  Appliesto RCM 3400 Prototyping Board.

RETURN VALUE
A voltage value corresponding to the voltage on the analog input channel.

ADOVERFL OW/(defined macro = -4096) if overflow or out of range.

SEE ALSO
anal nCal i b, analn, anal nmAnps, brdlnit
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float anal nD ff(unsigned int channel,
unsi gned i nt gai ncode);

Reads the state of differential analog input channels and uses the previously set calibration constants to

convert it to volts.

PARAMETERS

channel istheanalog input channel number (0 to 7) corresponding to ADC_INOto ADC_IN7

channel

Dl FF

Voltage Range
V)

+AINO -AIN1

-20to +20"

+AIN1 -AIN1

+AIN2 -AIN3

-20to +20°

+AIN3 -AIN3

+AIN4 -AINS

-20to +20"

+AINS -AINS

+AING -AIN7

~N|o g AW N O

+AIN7 -AIN7

gai ncode isthegain codeof 0to 7.

RETURN VALUE

*  Accessible on RCM 3400 Prototyping Board.

Gain Code | Multiplier | Voltage Range’
(V)
0 x1 0-20
1 x2 0-10
2 x4 0-5
3 x5 04
4 x8 0-25
5 x10 0-2
6 x16 0-1.25
7 x20 0-1

*  Appliesto RCM 3400 Prototyping Board.

A voltage value corresponding to the voltage on the analog input channel.
ADOVERFL OW(defined macro = -4096) if overflow or out of range.

SEE ALSO

anal nCal i b, anal n,

anal nmAnps, brdlnit

User’s Manual

83



i nt anal nmAnps(unsi gned i nt channel);

Reads the state of an analog input channel and uses the previously set calibration constants to convert it
to current.

PARAMETERS
channel isthe channel number (0-7):

4-20 mA
Input Lines”

+AINO
+AIN1
+AIN2

Channel Code

+AIN3T

+AIN4T

+AIN5'

Ol Ml WM —L|O

+AINGT
7 +AIN7

* Negative input is ground.
Tt Appliesto Prototyping Board.

RETURN VALUE
A current value between 4.00 and 20.00 mA corresponding to the current on the analog input channel.

ADOVERFL OW/(defined macro = -4096) if overflow or out of range.

SEE ALSO
anal nCali b, analn, analnVolts
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root int anal nEERd(unsi gned int channel,
unsi gned i nt opnode, unsigned int gaincode);

Reads the calibration constants, gain, and offset for an input based on their designated position in the
simulated EEPROM area of the flash memory, and places them into global tables for analog inputs. The
constants are stored in the top 2K of the reserved user block memory area Ox1C00-0x1FFF. Depending
on the flash size, the following macros can be used to identify the starting address for these locations.

ADC_CALI B_ADDRS, address start of single-ended analog input channels
ADC_CALI B_ADDRD, address start of differential analog input channels
ADC_CALI B_ADDRM address start of milliamp analog input channels

NOTE: Thisfunction cannot be runin RAM.
PARAMETER
channel istheanalog input channel number (0 to 7) corresponding to ADC_INOto ADC_IN7.
opnode isthe mode of operation:

SI NGLE—single-ended input line
DI FF—differential input line
mMAMP—milliamp input line

channel SI NGLE Dl FF mMAMP
0 +AINO +AINO -AIN1 +AINO"
1 +AIN1 +AIN1 -AINO" +AIN1"
2 +AIN2 +AIN2 -AIN3 +AIN2"
3 +AIN3 +AIN3 -AIN2" +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AIN5 -AIN4" +AIN5
6 +AING +AING -AIN7" +AING
7 +AIN7 +AIN7 -AIN6" +AIN7"

ALLCHAN read all channelsfor selected opnode

* Not accessible on Prototyping Board.

User’s Manual 85



gai ncode isthegain code of 0to 7. Thegai ncode parameter isignored when channel isALLCHAN.

B Cane Voltage Range*
V)

0-20
0-10
0-5
04
0-25
0-2
0-1.25

7 0-1

||~ W|IN| | O

*  Appliesto Prototyping Board.

RETURN VALUE
0if successful.
-1if addressisinvalid or out of range.
SEE ALSO
anal nEEW, analnCalib
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i nt anal nEEW (unsi gned i nt channel, int opnode
unsi gned i nt gai ncode);
Writes the calibration constants, gain, and offset for an input based from global tables to designated posi-
tionsin the simulated EEPROM area of the flash memory. The constants are stored in the top 2K of the

reserved user block memory area 0x1CO0—0x1FFF. Depending on the flash size, the following macros
can be used to identify the starting address for these locations.

ADC_CALI B_ADDRS, address start of single-ended analog input channels
ADC_CALI B_ADDRD, address start of differential analog input channels
ADC_CALI B_ADDRM address start of milliamp analog input channels

NOTE: Thisfunction cannot be runin RAM.
PARAMETER
channel istheanalog input channel number (0 to 7) corresponding to ADC_INOto ADC_IN7.
opnode isthe mode of operation:

SI NGLE—single-ended input line
DI FF—differential input line
mAMP—milliamp input line

channel SI NGLE Dl FF mAVP
0 +AINO +AINO -AIN1 +AINO"
1 +AIN1 +AIN1 -AINO +AINT"
2 +AIN2 +AIN2 -AIN3 +AIN2
3 +AIN3 +AIN3 -AIN2" +AIN3
4 +AIN4 +AIN4 -AIN5 +AIN4
5 +AIN5 +AINS5 -AIN4" +AIN5
6 +AING +AING -AIN7" +AING
7 +AIN7 +AIN7 -AIN6" +AIN7"

ALLCHAN read all channelsfor selected opnode

* Not accessible on Prototyping Board.
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gai ncode isthegain code of 0to 7. Thegai ncode parameter isignored when channel isALLCHAN.

Gain Code | Voltage Range’
V)

0-20
0-10
0-5
04
0-25
0-2
0-1.25

7 0-1

|| B~ W[N] O

*  Appliesto Prototyping Board.

RETURN VALUE

0if successful
-1if addressisinvalid or out of range.

SEE ALSO
anal nEEW, analnCalib
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APPENDIX C. USING THE TCP/IP
FEATURES

C.1 TCP/IP Connections

Programming and devel opment can be done with the RCM 3400 modul es without connect-
ing the Ethernet port on the RCM 3400 Prototyping Board to a network. However, if you
will be running the sample programs that use the Ethernet capability or will be doing Eth-
ernet-enabled development, you should connect the RCM 3400 Prototyping Board's Ether-
net port at thistime.

Before proceeding you will need to have the following items.

 If you don’'t have Ethernet access, you will need at least a 10Base-T Ethernet card
(available from your favorite computer supplier) installed in a PC.

* Two RJ}45 straight through Ethernet cables and a hub, or an RJ-45 crossover Ethernet
cable.

The Ethernet cables and a 10Base-T Ethernet hub are available from Z-World ina TCP/IP
tool kit. More information is available at www.zworld.com.

1. Connect the AC adapter and the programming cable as shown in Chapter 2, “ Getting
Started.”

2. Ethernet Connections

There are four options for connecting the RCM 3400 Prototyping Board to a network
for development and runtime purposes. The first two options permit total freedom of
action in selecting network addresses and use of the “network,” as no action can inter-
fere with other users. We recommend one of these options for initial development.

* No LAN — Thesimplest alternative for desktop development. Connect the RCM 3400
Prototyping Board's Ethernet port directly to the PC's network interface card using an
RJ-45 crossover cable. A crossover cableisaspecial cable that flips some connections
between the two connectors and permits direct connection of two client systems. A
standard RJ-45 network cable will not work for this purpose.

* Micro-LAN — Another smple alternative for desktop development. Use a small Eth-
ernet 10Base-T hub and connect both the PC’s network interface card and the
RCM 3400 Prototyping Board's Ethernet port to it using standard network cables.
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3.

The following options require more care in address selection and testing actions, as
conflicts with other users, servers and systems can occur:

LAN — Connect the RCM 3400 Prototyping Board's Ethernet port to an existing LAN,
preferably one to which the development PC is already connected. You will need to
obtain IP addressing information from your network administrator.

WAN — The RCM3400 is capable of direct connection to the Internet and other Wide
Area Networks through the Prototyping Board, but exceptional care should be used
with IP address settings and all network-related programming and devel opment. We
recommend that development and debugging be done on alocal network before con-
necting a RabbitCore system to the Internet.

TIP: Checking and debugging theinitial setup on amicro-LAN is recommended before
connecting the system to aLAN or WAN.

The PC running Dynamic C through the serial port on the RCM 3400 Prototyping Board
does not need to be the PC with the Ethernet card.

Apply Power

Plug in the AC adapter. The RCM 3400 module and Prototyping Board are now ready to
be used.
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C.2 TCP/IP Primer on IP Addresses

Obtaining IP addresses to interact over an existing, operating, network can involve a num-
ber of complications, and must usually be done with cooperation from your |SP and/or
network systems administrator. For thisreason, it is suggested that the user begin instead
by using a direct connection between a PC and the RCM 3400 using an Ethernet crossover
cable or asimple arrangement with ahub. (A crossover cable should not be confused with
regular straight through cables.)

In order to set up this direct connection, the user will have to use avirgin PC (right out of
the box), or disconnect a PC from the corporate network, or install a second Ethernet
adapter and set up a separate private network attached to the second Ethernet adapter. Dis-
connecting your PC from the corporate network may be easy or nearly impossible,
depending on how it is set up. If your PC boots from the network or is dependent on the
network for some or all of its disks, then it probably should not be disconnected. If a sec-
ond Ethernet adapter is used, be aware that Windows TCP/IP will send messages to one
adapter or the other, depending on the IP address and the binding order in Microsoft prod-
ucts. Thus you should have different ranges of 1P addresses on your private network from
those used on the corporate network. If both networks service the same | P address, then
Windows may send a packet intended for your private network to the corporate network.
A similar situation will take placeif you use a dial-up line to send a packet to the Internet.
Windows may try to send it viathe local Ethernet network if it isalso valid for that net-
work.

The following I P addresses are set aside for local networks and are not allowed on the
Internet: 10.0.0.0 to 10.255.255.255, 172.16.0.0 to 172.31.255.255, and 192.168.0.0 to
192.168.255.255.

The RCM 3400 Prototyping Board uses a 10Base-T type of Ethernet connection, whichis
the most common scheme. The RJ-45 connectors are similar to U.S. style telephone con-
nectors, are except larger and have 8 contacts.

An aternative to the direct connection using a crossover cable isadirect connection using
ahub. The hub relays packets received on any port to all of the ports on the hub. Hubs are
low in cost and are readily available. The RCM 3400 Prototyping Board uses 10 Mbps Eth-
ernet, so the hub or Ethernet adapter must be either a 10 Mbps unit or a 10/100 unit that
adaptsto 10 Mbps.

In a corporate setting where the Internet is brought in via a high-speed line, there are typi-
cally machines between the outside Internet and the internal network. These machines
include a combination of proxy servers and firewalls that filter and multiplex Internet traf-
fic. In the configuration below, the RCM 3400 Prototyping Board could be given afixed
address so any of the computers on the local network would be ableto contact it. It may be
possible to configure the firewall or proxy server to allow hosts on the Internet to directly
contact the controller, but it would probably be easier to place the controller directly on
the external network outside of the firewall. This avoids some of the configuration compli-
cations by sacrificing some security.
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RCM 3400
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If your system administrator can give you an Ethernet cable along with its | P address, the
netmask and the gateway address, then you may be able to run the sample programs with-
out having to setup a direct connection between your computer and the RCM 3400. You
will also need the IP address of the nameserver, the name or |P address of your mail

server, and your domain name for some of the sample programs.
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C.2.1 IP Addresses Explained

IP (Internet Protocol) addresses are expressed as 4 decimal numbers separated by periods,
for example:

216.103.126.155
10.1.1.6

Each decimal number must be between 0 and 255. The total |P addressis a 32-bit number
consisting of the 4 bytes expressed as shown above. A local network uses a group of adja-

cent IP addresses. There are always 2\ |P addressesin alocal network. The netmask (also
called subnet mask) determines how many | P addresses belong to the local network. The
netmask is also a 32-bit address expressed in the same form as the | P address. An example
netmask is:

255.255.255.0

This netmask has 8 zero bits in the least significant portion, and this means that 28
addresses are a part of the local network. Applied to the IP address above
(216.103.126.155), this netmask would indicate that the following I P addresses belong to
the local network:

216.103.126.0
216.103.126.1
216.103.126.2
etc.
216.103.126.254
216.103.126.255

The lowest and highest address are reserved for special purposes. The lowest address
(216.102.126.0) is used to identify the local network. The highest address
(216.102.126.255) is used as a broadcast address. Usually one other addressis used for the
address of the gateway out of the network. Thisleaves 256 - 3 = 253 available IP
addresses for the example given.
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C.2.2 How IP Addresses are Used

The actual hardware connection via an Ethernet uses Ethernet adapter addresses (also
called MAC addresses). These are 48-bit addresses and are unique for every Ethernet
adapter manufactured. In order to send a packet to another computer, given the |P address
of the other computer, it isfirst determined if the packet needs to be sent directly to the
other computer or to the gateway. In either case, thereis an IP address on the local net-
work to which the packet must be sent. A table is maintained to allow the protocol driver
to determine the MA C address corresponding to a particular |P address. If thetableis
empty, the MAC address is determined by sending an Ethernet broadcast packet to all
devices on the local network asking the device with the desired | P address to answer with
its MAC address. In thisway, the table entry can befilled in. If no device answers, then
the device is nonexistent or inoperative, and the packet cannot be sent.

| P addresses are arbitrary and can be allocated as desired provided that they don’t conflict
with other IP addresses. However, if they are to be used with the Internet, then they must
be numbers that are assigned to your connection by proper authorities, generaly by dele-
gation viayour service provider.

Each RCM 3400 RabbitCore module has its own MAC address, which consists of the pre-
fix 0090C2 followed by a code that is unique to each RCM 3400 module. For example, a
MAC address might by 0090C2C002CO0.

TIP: You can always obtain the MAC address on your board by running the sample pro-
gram DI SPLAY_MAC. Cfrom the SAMPLES\ TCPI P folder.
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C.2.3 Dynamically Assigned Internet Addresses

In many instances, there are no fixed | P addresses. Thisisthe case when, for example, you
are assigned an | P address dynamically by your dial-up Internet service provider (ISP) or
when you have a device that provides your | P addresses using the Dynamic Host Configu-
ration Protocol (DHCP). The RCM 3400 modules can use such | P addresses to send and
receive packets on the Internet, but you must take into account that this 1P address may
only be valid for the duration of the call or for a period of time, and could be a private IP
address that is not directly accessible to others on the Internet. These private address can
be used to perform some Internet tasks such as sending e-mail or browsing the Web, but
usually cannot be used to participate in conversations that originate el sewhere on the
Internet. If you want to find out this dynamically assigned | P address, under Windows 98
you can run thewi ni pcf g program while you are connected and look at the interface
used to connect to the Internet.

Many networks use private | P addresses that are assigned using DHCP. When your com-
puter comes up, and periodically after that, it requests its networking information from a
DHCP server. The DHCP server may try to give you the same address each time, but a
fixed IP address is usually not guaranteed.

If you are not concerned about accessing the RCM 3400 from the Internet, you can place
the RCM 3400 on the internal network using a private address assigned either statically or
through DHCP,
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C.3 Placing Your Device on the Network

In many corporate settings, users are isolated from the Internet by afirewall and/or a
proxy server. These devices attempt to secure the company from unauthorized network
traffic, and usually work by disallowing traffic that did not originate from inside the net-
work. If you want users on the Internet to communicate with your RCM 3400, you have
several options. You can either place the RCM 3400 directly on the Internet with areal
Internet address or place it behind the firewall. If you place the RCM 3400 behind the fire-
wall, you need to configure the firewall to translate and forward packets from the Internet
to the RCM 3400.
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C.4 Running TCP/IP Sample Programs

We have provided a number of sample programs demonstrating various uses of TCP/IP for
networking embedded systems. These programs require you to connect your PC and the
RCM 3400 board together on the same network. This network can be alocal private net-
work (preferred for initial experimentation and debugging), or aconnection viathe Internet.

Rgll\gtﬁ?o RCM 3400
System

N
User's PCK/ N

/ Ethernet /"/
Ethernet cables

crossover m m/m EL\> To additional

cable network
Hub u elements

Direct Connection _ . _
(Network of 2 computers) Direct Connection Using a Hub
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C.4.1 How to Set IP Addresses in the Sample Programs

With the introduction of Dynamic C 7.30 we have taken steps to make it easier to run
many of our sample programs. You will see a TCPCONFI G macro. This macro tells
Dynamic C to select your configuration from alist of default configurations. You will
have three choices when you encounter a sample program with the TCPCONFI G macro.

1. You can replace the TCPCONFI G macro with individual MY_I P_ADDRESS,
MY_NETMASK, MY_GATEWAY, and MY_NAMESERVER macros in each program.

2. You can leave TCPCONFI Gat the usual default of 1, which will set the | P configurations
t010. 10. 6. 100, the netmask to 255. 255. 255. 0, and the nameserver and gateway
t010. 10. 6. 1. If you would like to change the default values, for example, to usean IP
addressof 10. 1. 1. 2 for the RCM 3400 board, and 10. 1. 1. 1 for your PC, you can
edit the values in the section that directly follows the “ General Configuration” com-
ment in the TCP_CONFI G. LI B library. You will find thislibrary inthe LI B\ TCPI P
directory.

3. You can create a CUSTOM _CONFI G. LI B library and use a TCPCONFI Gvalue greater
than 100. Instructions for doing this are at the beginning of the TCP_CONFI G. LI B
library inthe LI B\ TCPI P directory.

There are some other “standard” configurations for TCPCONFI Gthat let you select differ-
ent features such as DHCP. Their values are documented at the top of the

TCP_CONFI G. LI Blibrary inthe LI B\ TCPI P directory. More information is availablein
the Dynamic C TCP/IP User’s Manual.

I P Addresses Before Dynamic C 7.30

Most of the sample programs use macros to define the | P address assigned to the board and
the | P address of the gateway, if thereis agateway. Instead of the TCPCONFI G macro, you
will seeaMY_| P_ADDRESS macro and other macros.

#define MY_| P_ADDRESS " 10. 10. 6. 170"

#define MY_NETMASK " 255. 255. 255. 0"

#defi ne MY_GATEWAY "10. 10. 6. 1"
#def i ne MY_NAMESERVER " 10. 10. 6. 1"

In order to do adirect connection, the following IP addresses can be used for the RCM 3400:

#define MY_| P_ADDRESS "10.1.1.2"
#define MY_NETMASK " 255. 255. 255. 0"
/1 #define MY_GATEWAY "10.10.6. 1"
/1 #define MY_NAMESERVER "10. 10. 6. 1"
In this case, the gateway and nameserver are not used, and are commented out. The IP
address of the board isdefined to be 10. 1. 1. 2. The IP address of you PC can be defined

as10.1.1.1.
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C.4.2 How to Set Up your Computer’s IP Address for Direct Connect

When your computer is connected directly to the RCM 3400 Prototyping Board via an
Ethernet connection, you need to assign an | P address to your computer. To assign the PC
the address 10. 1. 1. 1 with the subnetmask 255. 255. 255. 0, do the following.

Click on Start > Settings > Control Panel to bring up the Control Panel, and then
double-click the Network icon. Depending on which version of Windows you are using,
look for the TCP/IP Protocol/Network > Dial-Up Connections/Network line or tab.
Double-click onthisline or select Properties or Local Area Connections > Properties
to bring up the TCP/IP properties dialog box. You can edit the IP address and the subnet
mask directly. (Disable “obtain an IP address automaticaly”.) You may want to write
down the existing values in case you have to restore them later. It is not necessary to edit
the gateway address since the gateway is not used with direct connect.

RCM 3400
IP10.1.11 System
Subnet mask
255.255.255.0
g
User's PC
#define My_I P_ADDRESS "10.1.1. 2"
Ethernet
Crossover  #define MY_NETMASK " 255. 255. 255. 0"
cable

Direct Connection PC to RCM 3400 Board
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C.5 Run the PI NGVE. CDemo

In order to run the demo program, edit the | P address and netmask in the

TCP_CONFI G. LI B library tothevalues 10. 1. 1. 2 and 255. 255. 255. 248 for adirect
connection. Compile the program and start it running under Dynamic C. The crossover
cable is connected from your computer’s Ethernet adapter to the RCM 3400 board’'s RJ-45
Ethernet connector. When the program starts running, the green LNK light on the

RCM 3400 Prototyping Board should be on to indicate an Ethernet connection is made.
(Note: If the LNK light does not light, you may not have a crossover cable, or if you are
using a hub perhaps the power is off on the hub.)

The next step isto ping the board from your PC. This can be done by bringing up the MS-
DOS window and running the pingme program:

ping 10.1.1.2
or by Start > Run

and typing the entry

ping 10.1.1.2

Notice that the red ACT light flashes on the RCM 3400 Prototyping Board while the ping
istaking place, and indicates the transfer of data. The ping routine will ping the board four
times and write a summary message on the screen describing the operation.

C.6 Running More Demo Programs With Direct Connect

The program STATI C. C (SAMPLES\ TCPI P\ HTTP) demonstrates how to make the

RCM 3400 board be a Web server. In order to run these sample programs, open the sample
program, compile the program, and start it executing. Then bring up your Web browser
and enter the following server address: http://10.1.1.2.

This should bring up the Web page served by the sample program.

The sample program RXSAMPLE. C (SAMPLES\ TELNET) allows you to communicate with
the RCM 3400 using the Telnet protocol. To run this program, edit the I P address, compile
the program, and start it running. Run the Telnet program on your PC (Start > Run

tel net 10.1. 1. 2). Each character you type will be printed in Dynamic C's STDIO
window, indicating that the board is receiving the characters typed via TCP/IP.
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C.7 Where Do | Go From Here?

NOTE: If you purchased your RCM 3400 through a distributor or through a Z-World or
Rabbit Semiconductor partner, contact the distributor or Z-World partner first for tech-
nical support.

If there are any problems at this point:

¢ Check the Z-World/Rabbhit Semiconductor Technical Bulletin Board at
www.zworld.com/support/bb/.

» Usethe Technica Support e-mail form at www.zworld.com/support/support_submit.html.

If the sample programs ran fine, you are now ready to go on.
Additional sample programs are described in the Dynamic C TCP/IP User’s Manual.

Please refer to the Dynamic C TCP/IP User’'s Manual to develop your own applications.
An Introduction to TCP/I P provides background information on TCP/IP, and is available
on the CD and on Z-World's Web site.
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APPENDIX D. LCD/KEYPAD MODULE

An optiona LCD/keypad is available for the Prototyping Board.
Appendix C describes the LCD/keypad and provides the soft-
ware APIsto make full use of the LCD/keypad.

D.1 Specifications

Two optional LCD/keypad modules—with or without a panel-mounted NEMA 4 water-
resistant bezel—are available for use with the RCM 3400 Prototyping Board. They are
shown in Figure D-1.

LCD/Keypad Modules

0O @000000 o ececocoo0

<BaN vl
-J -+l

Figure D-1. LCD/Keypad Modules Versions

One version (no bezel) mounts directly on the Prototyping Board, and the other version is
designed to be installed at a remote location up to 60 cm (24") away. Contact your
Z-World sales representative or your authorized Z-World distributor for further assistance
in purchasing an L CD/keypad module.
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Mounting hardware and a 60 cm (24") extension cable are also available for the
L CD/keypad module through your Z-World sales representative or authorized distributor.

Table D-1 lists the electrical, mechanical, and environmental specifications for the
L CD/keypad module.

Table D-1. LCD/Keypad Specifications

Parameter Specification
! 2.60" x 3.00" x 0.75"
Board Size (66 mMm x 76 mm x 19 mm)
Operating Range: 0°C to +50°C
Temperature Storage Range: —40°C to +85°C
Humidity 5% to 95%, honcondensing
Power Consumption 1.5 W maximum"
Connections Connects to high-rise header sockets on the Prototyping Board
LCD Panel Size 122 x 32 graphic display
Keypad 7-key keypad
LEDs Seven user-programmable LEDs

* The backlight adds approximately 650 mW to the power consumption.
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D.2 Jumper-Selectable Voltage Settings for All Boards

Before using the L CD/keypad module, set the voltage for 3.3 V by setting the jumper
across pins 34 on header J5 as shown in Figure D-2.

LCD/Keypad Module Jumper Configurations

o Pins Factory
Header Description Connected Default
28V 1-2 X
J5 33V 34
5V nc.
i E g CR1
[ =

6
om Om Om Onm
R RI3__ Ri4 5 O
OO (C0 (Cn [Col (T _

J5 =
1

7[[LI
Part No. 101-0541

DISPLAY
BOARD

O

Figure D-2. LCD/Keypad Module Voltage Settings

NOTE: Older LCD/keypad modulesthat do not have a header at J5 are limited to operate
only at 5V, and will not work with the RCM 3400 Prototyping Board. The ol der
L CD/keypad modules are no longer being sold.
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D.3 Keypad Labeling

The keypad may be labeled according to your needs. A templateis providedin Figure D-3
to allow you to design your own keypad label insert.

2.35
(60)

Figure D-3. Keypad Template

To replace the keypad legend, remove the old legend and insert your new legend prepared
according to the template in Figure D-3. The keypad legend is located under the blue key-
pad matte, and is accessible from the left only as shown in Figure D-4.

Keypad label is located

under the blue keypad matte. O CJelelelele]e) O

)

Boo

Figure D-4. Removing and Inserting Keypad Label

106 RabbitCore RCM3400



D.4 Header Pinouts
Figure D-5 shows the pinouts for the L CD/keypad module.

J1

/CS | o o|/RES

A2B |0 o|A3B
+5BKLT (o m| VCC

GND |o of| GND

DB1B |o o | DBOB
AOB o o|A1B

GND | o o LED7

DB7B |- o | DB6B
DB5B | o o | DB4B
DB3B |o o| DB2B
LED6 | o o | LED5S
LED4 o o| LED3
LED2 o o| LED1

GND
DB6B
DB4B
DB2B
DBOB
AOB (B T | A1B

J3 J2

A2B |0 E| A3B
GND (o ©o|GND
GND |8 B |LED7
LEDG | o o |LED5S

LED4 |o ©|LED3
PE7 |© ©|/RES

GND |& ©
DB7B |® ©
DB5B |2 ©
DB3B |= ©
DB1B |7 ©
LED2 o o|LED1
+5BKLT [0 W |VCC

Figure D-5. LCD/Keypad Module Pinouts

D.4.1 1/0 Address Assignments

The LCD and keypad on the L CD/keypad module are addressed by the /CS strobe as
explained in Table D-2.

Table D-2. LCD/Keypad Module Address Assighment

Address Function
0xC000 Device select base address (/CS)
OXCxx0-0xCxx7 LCD control
0xCxx8 LED enable
O0xCxx9 Not used
OXCxxA 7-key keypad
OXCxxB (bits 0-6) 7-LED driver
OXCxxB (hit 7) LCD backlight on/off
OXCxxC—ExxF Not used
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D.5 Mounting LCD/Keypad Module on the Prototyping Board

Install the L CD/keypad module on header sockets LCD1JA, LCD1JB, and LCD1JC of the
Prototyping Board as shown in Figure D-6. Be careful to align the pins over the headers,
and do not bend them as you press down to mate the L CD/keypad module with the Proto-

typing Board.

o <[N8

HOROHOROO-O-OROOO- OO

OV0V0000V0VOVOVV0Q0O!
0000000000000 0000

Q

00000000000008000

00000000000
00000Q000Q0!
slelelelelelo]ole]
0000Q0QQO
slelelelelelo]olo]
Q0Q Q
o]
Q
o]

00
Q0Q
000
Q0
000
Q0Q Q0
00000000
Q0Q
000
Q0Q
000
QO

O
9
O
0000000
slelelelelelo]o]0]0]
0000Q00QQ0!
slelelelolelo]o]0]0]
00Q0QQO!
slelelelolelo]o]0]0]
0000Q000Q0

[o]e]
o]
[e]

Figure D-6. Install LCD/Keypad Module on Prototyping Board
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D.6 Bezel-Mount Installation

This section describes and illustrates how to bezel-mount the LCD/keypad module
designed for remote installation. Follow these steps for bezel-mount installation.

1. Cut mounting holesin the mounting panel in accordance with the recommended dimen-

sionsin Figure D-7, then use the bezel faceplate to mount the LCD/keypad module
onto the panel.

2. Carefully “drop in” the LCD/keypad module with the bezel and gasket attached.

—b—-

\ 7/
N ,
\ L
\ p
curtourt
// \
, \
4 \

!
‘ 7/
7/
7/

3.400
(86.4)

Figure D-7. Recommended Cutout Dimensions

/ \
//‘ \
- ————— — &
<> 0.230
(5.8)
2.870 .
(72.9)
3.100
(78.8)

*63) ‘ﬂ
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3. Fasten the unit with the four 4-40 screws and washers included with the LCD/keypad
module. If your panel isthick, use a4-40 screw that is approximately 3/16" (5 mm)
longer than the thickness of the panel.

/7 Bezel/Gasket

OEN ON OFR ON Om ON On
00 1 A o
am I 2D 2m Zng

g i ivm e )

Figure D-8. LCD/Keypad Module Mounted in Panel (rear view)

Carefully tighten the screws until the gasket is compressed and the plastic bezel face-
plate is touching the panel.

Do not tighten each screw fully before moving on to the next screw. Apply only one or
two turnsto each screw in sequence until all are tightened manually as far asthey can
be so that the gasket is compressed and the plastic bezel faceplate is touching the panel.
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D.6.1 Connect the LCD/Keypad Module to Your Prototyping Board

The LCD/keypad module can be located as far as 2 ft. (60 cm) away from the RCM 3400
Prototyping Board, and is connected via a ribbon cable as shown in Figure D-9.

161070.161016616.6616166010.¢
ojeloleloleloolel0l0l0]0l0]0T0ld
DO000000000000000¢ <

O
Q
Q
Q
Q
Q
Q
Q
Q0
00
o
Q
Q
Q
Q
Q

)10.0.0.0.0.0.0.0.0.0.0,0.0:0.0.0.0.0.0.¢

IQO00Q)
Q00
YOO

‘

HE OE OER OE OR OE Om

fthﬂﬁf:!ﬂho
30020 Zrm

goop
«| doop

doop| ¢
doop
2 | doop|
doop| 9
gomp
= 2T

Figure D-9. Connecting LCD/Keypad Module to RCM3400 Prototyping Board

Note the locations and connections relative to pin 1 on both the RCM 3400 Prototyping
Board and the L CD/keypad module.

Z-World offers 2 ft. (60 cm) extension cables. Contact your authorized Z-World distributor
or aZ-World sales representative at +1(530)757-3737 for more information.
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D.7 Sample Programs

Sample programs illustrating the use of the LCD/keypad module with the Prototyping
Board are provided in the SAMPLES\ RCVB400 directory.

These sample programs use the auxiliary 1/0 bus on the Rabbit 3000 chip, and so the
#def i ne PORTA_AUX | Olineisalready included in the sample programs.

Each sample program has comments that describe the purpose and function of the pro-
gram. Follow the instructions at the beginning of the sample program. To run a sample
program, open it with the File menu (if it is not still open), compile it using the Compile
menu, and then run it by selecting Run in the Run menu. The RCM 3400 must bein
Program mode (see Section 3.3, “Programming Cable”), and must be connected to a PC
using the programming cable as described in Chapter 2, “ Getting Started.”.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.

The following sample programs are found in the LCD_KEYPAD subdirectory in
SAMPLES\ RCV3400.

* KEYPADTOLED. G—This program demonstrates the use of the external 1/O bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when akey pressis detected. The DS1 and DS2 LEDs on the Prototyping
Board will aso light up.

* LCDKEYFUN. C—This program demonstrates how to draw primitive features from the
graphic library (lines, circles, polygons), and also demonstrates the keypad with the key
release option.

e SW TCHTOLED. C—This program demonstrates the use of the external 1/O bus. The
program will light up an LED on the LCD/keypad module and will display a message
on the LCD when a switch pressis detected. The DS1 and DS2 LEDs on the Prototyp-
ing Board will also light up.

Additional sample programs are available in the 122x32_1x7 subdirectory in
SAMPLES\ LCD_KEYPAD.
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D.8 LCD/Keypad Module Function Calls

When mounted on the Prototyping Board, the L CD/keypad module usesthe auxiliary 1/0
bus on the Rabbit 3000 chip. Remember to add the line

#define PORTA_AUX | O
to the beginning of any programs using the auxiliary 1/0 bus.

D.8.1 LCD/Keypad Module Initialization
void displnit();

Initializes the LCD/keypad module. The keypad is set up using keypadDef () or keyConfi g() after
this function call.

RETURN VALUE
None.

D.8.2 LEDs

When power is applied to the LCD/keypad module for the first time, thered LED (DS1)
will come on, indicating that power is being applied to the LCD/keypad module. The red
LED isturned off when the br dI ni t function executes.

One function is available to control the LEDs, and can be found in the RC\VB400. LI B
library in the SAMPLES\ RCMB3400 directory.

voi d di spledQut(int |led, int value);

LED on/off contral. This function will only work when the LCD/keypad moduleis installed on the
Prototyping Board.

PARAMETERS
| ed isthe LED to control.

0=LED DS1
1=LED DS2
2=LED DS3
3=LED D4
4=LED DS5
5=LED DS6
6=LED DS7

val ue isthe value used to control whether the LED ison or off (0 or 1).
0 = off
1=on
RETURN VALUE
None.

SEE ALSO
brdl nit
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D.8.3 LCD Display

The functions used to control the LCD display are contained in the GRAPHI C. LI B library
located in the Dynamic C DI SPLAYS\ GRAPHI C library directory.

void gllnit(void);

Initializes the display devices, clears the screen.

RETURN VALUE
None.

SEE ALSO

gl D spONnCFF, gl Backl i ght, gl Set Contrast, gl Pl otDot, gl Bl ock, gl Pl otDot,
gl Pl ot Pol ygon, glPlotCrcle, glHScroll, glVScroll, gl XFontlnit, glPrintf,
gl Put Char, gl SetBrushType, gl BuffLock, gl BuffUnlock, glPlotLine

voi d gl BackLi ght (i nt onOif);

Setsthe intensity of the backlight, if circuitry isinstalled.

PARAMETER
onOF f reflectsthe low to high values (typically 0 to 255, depending on the board design) to set the back-
light intensity (O will turn the backlight off completely.)

RETURN VALUE
None.

SEE ALSO
gllnit, gl D spOnoff, gl SetContrast

voi d gl Di spOnO f(int onOfif);

Sets the LCD screen on or off. Datawill not be cleared from the screen.
PARAMETER
onO f turnsthe LCD screen on or off

1—turn the LCD screen on
O—turn the LCD screen off

RETURN VALUE
None.

SEE ALSO
glInit, gl SetContrast, gl BackLi ght
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voi d gl Set Contrast (unsi gned | evel);

Sets display contrast (the circuitry is not installed on the L CD/keypad modul e used with the Prototyping
Board).

PARAMETER
I evel reflectslow to high values (typically 0to 255, depending on the board design) to give highto low
contrast respectively.

RETURN VALUE
None.

SEE ALSO
glInit, glBacklight, gl D spOnoff

void gl Fill Screen(char pattern);

Fillsthe LCD display screen with a pattern.

PARAMETER
The screenwill be setto all black if pat t er n isOxFF, all whiteif pat t er n is0x00, and vertical stripes
for any other pattern.

RETURN VALUE
None.

SEE ALSO
gl Bl ock, gl Bl ankScreen, gl Pl otPolygon, glPlotCircle

voi d gl Bl ankScr een(voi d);

Blanksthe LCD display screen (sets LCD display screen to white).

RETURN VALUE
None.

SEE ALSO
gl Fill Screen, gl Block, glPlotPolygon, glPlotCircle
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void gl Block(int x, int y, int bnmWdth,
i nt bnHei ght) ;

Draws arectangular block in the page buffer and on the LCD if the buffer isunlocked. Any portion of the
block that is outside the LCD display areawill be clipped.

PARAMETERS
X isthe x coordinate of the upper left corner of the block.
y isthey coordinate of the left top corner of the block.
bW dt h isthe width of the block.
bW dt h isthe height of the block.

RETURN VALUE
None.

SEE ALSO
gl Fill Screen, gl Bl ankScreen, gl PlotPolygon, glPlotCircle

voi d gl Pl ot VPol ygon(int n, int *pFirstCoord);

Plots the outline of a polygon in the LCD page buffer, and on the LCD if the buffer is unlocked. Any por-
tion of the polygon that is outside the LCD display areawill be clipped. The function will also return,
doing nothing, if there are less than 3 vertices.

PARAMETERS
n isthe number of vertices.
*pFi r st Coor d isapointer to array of vertex coordinates: x1, y1, x2,y2, x3,y3,...

RETURN VALUE
None.

SEE ALSO
gl Pl ot Pol ygon, gl Fill Pol ygon, gl Fill VPol ygon
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voi d gl Pl ot Pol ygon(int n, int yl, int x2, int y2,
Plots the outline of apolygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any por-

tion of the polygon that is outside the LCD display areawill be clipped. The function will also return,
doing nothing, if there are less than 3 vertices.

PARAMETERS
n isthe number of vertices.
y1 isthey coordinate of the first vertex.
x1 isthe x coordinate of the first vertex.
y2 isthey coordinate of the second vertex.
x2 isthe x coordinate of the second vertex.
. arethe coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
gl Pl ot VPol ygon, gl Fill Pol ygon, gl Fill VPol ygon

void gl FillVPol ygon(int n, int *pFirstCoord);

Fills a polygon in the LCD page buffer and on the LCD screen if the buffer is unlocked. Any portion of
the polygon that is outside the LCD display areawill be clipped. The function will aso return, doing
nothing, if there are less than 3 vertices.

PARAMETERS
n isthe number of vertices.
*pFi r st Coor d isapointer to array of vertex coordinates: x1, y1, x2,y2, x3,y3,...

RETURN VALUE
None.

SEE ALSO
gl Fi Il Pol ygon, gl Pl ot Pol ygon, gl Pl ot VPol ygon
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void glFillPolygon(int n, int x1, int yl, int X2,
int y2, ...);
Fillsapolygon in the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the poly-
gon that is outside the LCD display areawill be clipped.

PARAMETERS
n isthe number of vertices.

x1 isthe x coordinate of the first vertex.
y1 isthey coordinate of thefirst vertex.
X2 isthe x coordinate of the second vertex.
y2 isthey coordinate of the second vertex.
. arethe coordinates of additional vertices.

RETURN VALUE
None.

SEE ALSO
gl Fi Il VPol ygon, gl Pl ot Pol ygon, gl Pl ot VPol ygon

void glPlotCrcle(int xc, int yc, int rad);

Drawsacirclein the LCD page buffer and on the LCD if the buffer isunlocked. Any portion of thecircle
that is outside the LCD display areawill be clipped.

PARAMETERS
Xc¢ isthe x coordinate of the center of the circle.

yc isthey coordinate of the center of the circle.
r ad istheradius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
glFillCrcle, glPlotPolygon, glFillPolygon

void glFillGCrcle(int xc, int yc, int rad);

Draws afilled circlein the LCD page buffer and on the LCD if the buffer is unlocked. Any portion of the
circlethat isoutside the LCD display areawill be clipped.

PARAMETERS
xc isthe x coordinate of the center of the circle.

yc isthey coordinate of the center of thecircle.
r ad istheradius of the center of the circle (in pixels).

RETURN VALUE
None.

SEE ALSO
gl PlotCircle, glPlotPolygon, glFillPolygon
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void gl XFontInit(fontlnfo *plnfo, char pixWdth,
char pi xHei ght, unsigned start Char,
unsi gned endChar, unsigned | ong xnenBuffer);

Initializes the font descriptor structure, where the font is stored in xmem Each font character’'s bitmap is
column major and byte-aligned.

PARAMETERS
*pl nf o isapointer to the font descriptor to be initialized.

pi XxW dt h isthe width (in pixels) of each font item.

pi xHei ght isthe height (in pixels) of each font item.

st art Char isthevalue of the first printable character in the font character set.
endChar isthe value of the last printable character in the font character set.
xmenBuf f er isthe xmempointer to alinear array of font bitmaps.

RETURN VALUE
None.

SEE ALSO
gl Prinf

unsi gned | ong gl Font Char Addr (font | nfo *pl nf o,
char letter);

Returns the x memaddress of the character from the specified font set.

PARAMETERS
*pl nf o isthe xnmemaddress of the bitmap font set.

| etter isan ASCII character.

RETURN VALUE
xmemaddress of bitmap character font, column major, and byte-aligned.

SEE ALSO
gl PutFont, glPrintf
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void gl PutFont(int x, int y, fontlnfo *plnfo,
char code);
Puts an entry from the font table to the page buffer and on the LCD if the buffer is unlocked. Each font

character’s bitmap is column major and byte-aligned. Any portion of the bitmap character that is outside
the LCD display areawill be clipped.

PARAMETERS
X isthe x coordinate (column) of the upper left corner of the text.
y isthey coordinate (row) of the left top corner of the text.
*pl nf o isapointer to the font descriptor.
code isthe ASCII character to display.

RETURN VALUE
None.

SEE ALSO
gl Font Char Addr, gl Printf

voi d gl Set Pf Step(int stepX, int stepY);

Setsthegl Print f () printing step direction. Thex and y step directions are independent signed values.
The actual step increments depend on the height and width of the font being displayed, which are multi-
plied by the step values.

PARAMETERS
st epXisthegl Printf xstepvalue
stepYisthegl Printf ystepvalue

RETURN VALUE
None.

SEE ALSO
Usegl Get Pf St ep() to examinethe current x and y printing step direction.

int gl Get Pf St ep(void);

Getsthecurrent gl Pri nt f () printing step direction. Each step direction is independent of the other,
and istreated as an 8-bit signed value. The actual step increments depends on the height and width of the
font being displayed, which are multiplied by the step values.

RETURN VALUE
The x step isreturned in the MSB, and they step is returned in the LSB of the integer resullt.

SEE ALSO
Usegl Get Pf St ep() to control the x and y printing step direction.

120 RabbitCore RCM3400



voi d gl Put Char (char ch, char *ptr, int *cnt,
gl Put Char I nst *pl nst)
Provides an interface between the STDIO string-handling functions and the graphic library. The
STDIO string-formatting function will call this function, one character at atime, until the entire format-

ted string has been parsed. Any portion of the bitmap character that is outside the LCD display area will
be clipped.

PARAMETERS
ch isthe character to be displayed on the LCD.

*pt r isnot used, but isa place holder for STDIO string functions.
*cnt isnot used, isaplace holder for STDIO string functions.
*pl nst isafont descriptor pointer.

RETURN VALUE
None.

SEE ALSO
gl Printf, gl PutFont, doprnt

void glPrintf(int x, int y, fontlnfo *plnfo,
char *fnt, ...);

Prints a formatted string (much like pr i nt f ) on the LCD screen. Only the character codes that exist in
the font set are printed, all others are skipped. For example, \b', \t", \n’ and \r’ (ASCI| backspace, tab,
new line, and carriage return, respectively) will be printed if they exist in the font set, but will not have
any effect as control characters. Any portion of the bitmap character that is outside the LCD display area
will be clipped.

PARAMETERS
X isthe x coordinate (column) of the upper left corner of the text.

y isthey coordinate (row) of the upper left corner of the text.
*pl nf o isafont descriptor pointer.
*fmt isaformatted string.

. areformatted string conversion parameter(s).

EXAMPLE
glprintf(0,0, &fil2x16, "Test %\ n", count);

RETURN VALUE
None.

SEE ALSO
gl XFont | ni t
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voi d gl Buf f Lock(voi d);

Increments LCD screen locking counter. Graphic calls are recorded in the LCD memory buffer and are
not transferred to the LCD if the counter is non-zero.

NOTE: gl Buf f Lock() andgl Buf f Unl ock() can be nested uptoalevel of 255, but be
sureto balance the calls. It is not arequirement to use these procedures, but a set of
gl Buf f Lock() and gl Buf f Unl ock() bracketing aset of related graphic calls speeds
up the rendering significantly.

RETURN VALUE

None.

SEE ALSO
gl Buf f Unl ock, gl Swap

voi d gl Buf f Unl ock(voi d);

Decrements the LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD
if the counter goesto zero.

RETURN VALUE
None.

SEE ALSO
gl Buf f Lock, gl Swap

voi d gl Swap(voi d);

Checksthe LCD screen locking counter. The contents of the LCD buffer are transferred to the LCD if the
counter is zero.

RETURN VALUE
None.

SEE ALSO

gl Buf f Unl ock, gl BuffLock, _gl SwapData (located inthelibrary specifically for the LCD
that you are using)

voi d gl Set BrushType(int type);

Sets the drawing method (or color) of pixels drawn by subsequent graphic calls.

PARAMETER
t ype value can be one of the following macros.
Pl XBLACK draws black pixels.
Pl XWHI TE draws white pixels.
Pl XXOR draws old pixel XOR’ed with the new pixel.
RETURN VALUE
None.

SEE ALSO
gl Get BrushType
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int gl Get BrushType(void);
Gets the current method (or color) of pixels drawn by subsequent graphic calls.

RETURN VALUE
The current brush type.

SEE ALSO
gl Set BrushType

void glPlotDot(int x, int y);

Draws asingle pixel in the LCD buffer, and on the LCD if the buffer is unlocked. If the coordinates are
outside the LCD display area, the dot will not be plotted.

PARAMETERS
X isthe x coordinate of the dot.
y isthey coordinate of the dot.

RETURN VALUE
None.

SEE ALSO
gl Plotline, glPlotPolygon, glPlotCircle

void gl PlotLine(int xO0, int yO0, int x1, int yl);

Draws aline in the LCD buffer, and on the LCD if the buffer is unlocked. Any portion of the linethat is
beyond the LCD display areawill be clipped.

PARAMETERS
x0 isthe x coordinate of one endpoint of the line.
y0 isthey coordinate of one endpoint of the line.
x 1 isthe x coordinate of the other endpoint of the line.
y1 isthey coordinate of the other endpoint of the line.

RETURN VALUE
None.

SEE ALSO
gl Pl ot Dot, gl Pl ot Polygon, glPlotCrcle
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void gl Leftl(int left, int top, int cols, int rows);

Scrolls byte-aligned window | eft one pixel, right column isfilled by current pixel type (color).
PARAMETERS

| ef t isthe upper left corner of bitmap, must be evenly divisible by 8.

t op isthe left top corner of the bitmap.

col s isthe number of columnsin the window, must be evenly divisible by 8.

r ows isthe number of rows in the window.

RETURN VALUE
None.

SEE ALSO
gl HScroll, gl R ghtl

void glRightl(int left, int top, int cols, int rows);

Scrolls byte-aligned window right one pixel, left column isfilled by current pixel type (color).
PARAMETERS

| ef t isthe upper left corner of bitmap, must be evenly divisible by 8.

t op isthe left top corner of the bitmap.

col s isthe number of columnsin the window, must be evenly divisible by 8.

r ows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
gl HScrol |, glLeftl

void gl Upl(int left, int top, int cols, int rows);

Scrolls byte-aligned window up one pixel, bottom column isfilled by current pixel type (color).
PARAMETERS

| ef t isthe upper left corner of bitmap, must be evenly divisible by 8.

t op isthe left top corner of the bitmap.

col s isthe number of columnsin the window, must be evenly divisible by 8.

r ows is the number of rows in the window.

RETURN VALUE
None.

SEE ALSO
gl VScrol |, gl Downl
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void gl Downl(int left, int top, int cols, int rows);
Scrolls byte-aligned window down one pixel, top column is filled by current pixel type (color).
PARAMETERS
| ef t isthe upper left corner of bitmap, must be evenly divisible by 8.
t op isthe left top corner of the bitmap.
col s isthe number of columnsin the window, must be evenly divisible by 8.
r ows isthe number of rowsin the window.

RETURN VALUE
None.

SEE ALSO
gl VScrol I, gl Upl

void gl HScroll (int left, int top, int cols,
int rows, int nPix);

Scrollsright or left, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.

Parameters will be verified for the following:

1. Thel ef t and col s parameterswill be verified that they are evenly divisible by 8. If not, they will
be changed to avalue that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling areais valid. The minimum scrolling areais
awidth of 8 pixels and a height of one row.
PARAMETERS
| ef t isthe upper left corner of bitmap, must be evenly divisible by 8.
t op isthe left top corner of the bitmap.
col s isthe number of columnsin the window, must be evenly divisible by 8.
r ows isthe number of rowsin the window.
nPi x isthe number of pixelsto scroll within the defined window (a negative value will produce a scroll
to the left).

RETURN VALUE
None.

SEE ALSO
gl VScrol |
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void gl VScroll (int left, int top, int cols,
int rows, int nPiXx);
Scrolls up or down, within the defined window by x number of pixels. The opposite edge of the scrolled
window will be filled in with white pixels. The window must be byte-aligned.
Parameters will be verified for the following:

1. Thel eft and col s parameterswill be verified that they are evenly divisible by 8. If not, they will
be changed to avalue that is a multiple of 8.

2. Parameters will be checked to verify that the scrolling areais valid. The minimum scrolling areais
awidth of 8 pixels and a height of one row.

PARAMETERS
| ef t isthe upper left corner of bitmap, must be evenly divisible by 8.
t op isthe left top corner of the bitmap.
col s isthe number of columnsin the window, must be evenly divisible by 8.
r ows is the number of rows in the window.
nPi x isthe number of pixelsto scroll within the defined window (a negative value will produce a scroll
up).
RETURN VALUE
None.

SEE ALSO
gl HScrol |

void gl XPutBitmap(int left, int top, int wdth,
i nt height, unsigned | ong bitmap);

Draws bitmap in the specified space. The data for the bitmap are stored in xmem This function calls
gl XPut Fast map automatically if the bitmap is byte-aligned (the |eft edge and the width are each
evenly divisible by 8).

Any portion of abitmap image or character that is outside the LCD display areawill be clipped.

PARAMETERS
| ef t isthe upper left corner of the bitmap.

t op isthe upper left corner of the bitmap.
wi dt h isthe width of the bitmap.
hei ght isthe height of the bitmap.

bi t map isthe address of the bitmap in xnem

RETURN VALUE
None.

SEE ALSO
gl XPut Fast map, gl Printf
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voi d gl XPut Fastmap(int left, int top, int wdth,
I nt hei ght, unsigned | ong bitmap);
Draws bitmap in the specified space. The data for the bitmap are stored in xmem This functionis like
gl XPut Bi t map, except that it is faster. The restriction is that the bitmap must be byte-aligned.
Any portion of abitmap image or character that is outside the LCD display areawill be clipped.
PARAMETERS
| ef t isthe upper left corner of the bitmap, must be evenly divisible by 8.
t op isthe upper left corner of the bitmap.
wi dt h isthe width of the bitmap, must be evenly divisible by 8.
hei ght isthe height of the bitmap.
bi t map isthe address of the bitmap in xmem

RETURN VALUE
None.

SEE ALSO
gl XPut Bi t map, gl Printf

I nt Text W ndowFr ane(w ndowFr ane *w ndow,
fontInfo *pFont, int x, int y, int winWdth,
i nt Wi nHei ght)

Defines atext-only display window. This function provides away to display characters within the text
window using only character row and column coordinates. The text window feature provides end-of-line
wrapping and clipping after the character in the last column and row is displayed.

NOTE: Executethe Text W ndowrr ane function before other Text . . . functions.

PARAMETERS

*wi ndowisawindow frame descriptor pointer.

*pFont isafont descriptor pointer.

X isthe x coordinate of where the text window frameisto start.

y isthey coordinate of where the text window frameisto start.

wi nW dt h isthe width of the text window frame.

wi nHei ght isthe height of the text window frame.
RETURN VALUE

O—window frame was successfully created.

-1—x coordinate + width has exceeded the display boundary.
-2—y coordinate + height has exceeded the display boundary.
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voi d Text Got oXY(w ndowFrane *w ndow, int col,
I nt row);

Sets the cursor location on the display of where to display the next character. The display location is
based on the height and width of the character to be displayed.

NOTE: Executethe Text W ndowrr ane function before using this function.

PARAMETERS
*wi ndowisa pointer to afont descriptor.

col isacharacter column location.
r owis acharacter row location.

RETURN VALUE
None.

SEE ALSO
Text Put Char, TextPrintf, TextW ndowFrane

voi d Text Cur sor Locati on(w ndowFr ane *w ndow,
int *col, int *row);

Getsthe current cursor location that was set by a Graphic Text . . . function.

NOTE: Executethe Text W ndowrr ane function before using this function.
PARAMETERS
*wi ndowisa pointer to afont descriptor.
*col isapointer to cursor column variable.
*r owis apointer to cursor row variable.

RETURN VALUE
Lower word = Cursor Row location
Upper word = Cursor Column location

SEE ALSO
Text Got oXY, TextPrintf, Text W ndowFrane, Text CursorlLocation

voi d Text Put Char (struct w ndowFrane *w ndow, char ch);

Displays a character on the display where the cursor is currently pointing. If any portion of a bitmap
character is outside the LCD display area, the character will not be displayed.

NOTE: Executethe Text W ndowrr ame function before using this function.
PARAMETERS
*wi ndowisa pointer to afont descriptor.
ch isacharacter to be displayed on the LCD.

RETURN VALUE
None.

SEE ALSO
Text Got oXY, TextPrintf, Text W ndowFrane, Text CursorlLocation
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void TextPrintf(struct w ndowFrane *w ndow,
char *fnm, ...);
Prints aformatted string (much like pr i nt f ) on the LCD screen. Only printable characters in the font

set are printed, also escape sequences, \r’ and \n' are recognized. All other escape sequences will be
skipped over; for example, \b’ and 't’ will print if they exist in the font set, but will not have any effect as

control characters.
The text window feature provides end-of-line wrapping and clipping after the character in the last col-
umn and row is displayed.
NOTE: Executethe Text W ndowrr ane function before using this function.
PARAMETERS
*wi ndowisa pointer to afont descriptor.
*fmt isaformatted string.

. areformatted string conversion parameter(s).

EXAMPLE
Text Print f (&Text W ndow, "Test %\ n", count);

RETURN VALUE
None.

SEE ALSO
Text Got oXY, Text Put Char, Text W ndowFr ane, Text CursorlLocation
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D.8.4 Keypad

The functions used to control the keypad are contained in the KEYPADY?. LI B library
located in the Dynamic C KEYPADS library directory.

voi d keylnit(void);

Initializes keypad process

RETURN VALUE
None.

SEE ALSO
brdl nit

voi d keyConfi g(char cRaw, char cPress,
char cRel ease, char cCntHold, char cSpdLo,
char cCntLo, char cSpdH );

Assigns each key with key press and release codes, and hold and repeat ticks for auto repeat and
debouncing.

PARAMETERS
cRawisaraw key code index.

1x7 keypad matrix with raw key code index assignments (in brackets):

(0] [1] (2] [3]
[4] (5] [6]

User Keypad Interface
cPr ess isakey press code

An 8-bit valueis returned when akey is pressed.
0 = Unused.

See keypadDef () for default press codes.
cRel ease isakey release code.

An 8-bit valueis returned when akey is pressed.
0 = Unused.

cCnt Hol d isahold tick.

How long to hold before repeating.
0 = No Repeat.

cSpdLo isalow-speed repeat tick.

How many times to repeat.
0= None.

cCnt Lo isalow-speed hold tick.

How long to hold before going to high-speed repeat.
0=Slow Only.
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cSpdHi isahigh-speed repest tick.

How many times to repeat after low speed repeat.
0= None.

RETURN VALUE
None.

SEE ALSO
keyProcess, keyGet, keypadDef

Scans and processes keypad data for key assignment, debouncing, press and release, and repeat.

NOTE: Thisfunctionisalso able to process an 8 x 8 matrix keypad.

RETURN VALUE
None

SEE ALSO
keyConfig, keyGet, keypadDef

Get next keypress

RETURN VALUE
The next keypress, or 0 if none

SEE ALSO
keyConfig, keyProcess, keypadDef

Push keypress on top of input queue

PARAMETER
cKey

RETURN VALUE
None.

SEE ALSO
keyGet
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voi d keypadDef () ;

Configures the physical layout of the keypad with the desired ASCII return key codes.

RETURN VALUE

Keypad physical mapping 1 x 7

0

4

1

5 2

6

3

(L]

(-]

[U]

[D]

[+]

['E]

['R]

where

'E' represents the ENTER key
'D' represents Down Scroll

'U' represents Up Scroll

'R’ represents Right Scroll
‘L' represents Left Scroll

Example: Do the followingfor the above physical vs. ASCII return key codes.

keyConfig
keyConfig
keyConfig
keyConfig
keyConfi g
keyConfi g
keyConfi g

None.

SEE ALSO
keyConfi g,

e N R N N R N

3,’R

keyGet,

0, 0, 0, O,

0,

0
0
, 0
0
0

cooooo
coooo
cooooo

0,

keyProcess

voi d keyScan(char *pcKeys);

Writes"1" to each row and reads the value. The position of akeypressisindicated by azero valuein abit
position.

PARAMETER

*pcKeys isthe address of the value read.

RETURN VALUE

None.

SEE ALSO
keyConfi g,

keyGet ,

keypadDef,

keyProcess
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APPENDIX E. POWER SUPPLY

Appendix D provides information on the current requirements
of the RCM 3400, and includes some background on the chip
select circuit used in power management.

E.1 Power Supplies

The RCM3400 requires aregulated 2.8 V — 3.45 V DC power source. The RabbitCore
design presumes that the voltage regulator is on the user board, and that the power is made
available to the RCM 3400 board through header J1.

An RCM 3400 with no loading at the outputs operating at 29.4 MHz typicaly draws 97 mA.
E.1.1 Battery-Backup Circuits

The RCM 3400 does not have a battery, but there is provision for a customer-supplied bat-
tery to back up the data SRAM and keep the internal Rabbit 3000 real-time clock running.

Header J2, shown in Figure E-1, alows access to the external battery. This header makes
it possible to connect an external 3 V power supply. This allowsthe SRAM and the inter-
nal Rabbit 3000 real-time clock to retain data with the RCM 3400 powered down.

J2

GND 1 2
External

o Battery

33 34 VBAT_EXT I./

o o —

Figure E-1. External Battery Connections
at Header J5

A lithium battery with a nominal voltage of 3 V and a minimum capacity of 165 mA-his
recommended. A lithium battery is strongly recommended because of its nearly constant
nominal voltage over most of itslife.
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The drain on the battery by the RCM 3400 is typically 7.5 pHA when no other power is sup-
plied. If a 165 mA-h battery is used, the battery can last about 2.5 years:

165 mA-h

————— = 25years.

75 PA y
The actua lifein your application will depend on the current drawn by components not on
the RCM 3400 and on the storage capacity of the battery. Note that the shelf life of alithium
ion battery is ultimately 10 years. The RCM 3400 does not drain the battery whileit is pow-
ered up normally.

E.1.2 Reset Generator

The RCM 3400 uses areset generator to reset the Rabbit 3000 microprocessor when the volt-
age drops below the voltage necessary for reliable operation. The reset occurs between
285V and 3.00 V, typicaly 2.93 V. The RCM 3400 has areset output, pin 33 on header J1.
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APPENDIX F. PROGRAMMING CABLE

Appendix E provides additional information for the Rabbit 3000™
microprocessor when using the DIAG and PROG connectors on the
programming cable. The PROG connector is used only when the pro-
gramming cable is attached to the programming connector (header J2
on the Prototyping Board) while anew application is being devel oped.
Otherwise, the DIAG connector on the programming cable allows the
programming cable to be used as an RS-232 to CMOS level converter
for serial communication, which is appropriate for monitoring or
debugging a RabbitCore system whileit is running.
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The programming port, which is shown in Figure F-1, can serve as a convenient communica-
tions port for field setup or other occasional communication need (for example, as a diag-
nostic port). If the port is simply to perform a setup function, that is, write setup
information to flash memory, then the controller can be reset through the programming
port and a cold boot performed to start execution of a special program dedicated to this
functionality.

PROGRAMMING PORT PIN ASSIGNMENTS
(Rabbit LQFP pins are shown in parenthesis)
dL I e 1. RXA (66) — — — — — A+
3@ @ |4 2. GND ~50 kQ)
| el AP A
+ +
- K 5. RESET— — — — — — ANA- + <3
s]@ @0 6. TXA (67)
7. n.c.
Programming Port 8. STATUS (output) (4) .4
Pin Numbers 9. SMODEO (45) — — — {éé\ké\/- GND
10. SMODE1 (44) — — — —AAA- GND

Figure F-1. Programming Port Pin Assignments

When the PROG connector is used, the /RESET line can be asserted by manipulating
DTR and the STATUS line can be read as DSR on the serial port. The target can be
restarted by pulsing reset and then, after a short delay, sending a special character string at
2400 bps. To simply restart the BIOS, the string 80h, 24h, 80h can be sent. When the
BIOS is started, it can tell whether the programming cable is connected because the
SMODEL1 and SMODEDQ pins are sensed as being high.

Alternatively, the DIAG connector can be used to connect the programming port. The
/RESET line and the SMODE1 and SMODEDQ pins are not connected to this connector.
The programming port is then enabled as adiagnostic port by polling the port periodically
to see if communication needs to begin or to enable the port and wait for interrupts. The
pull-up resistorson RXA and CLKA prevent spurious data reception that might take place
if the pins floated.

If the clocked serial mode is used, the serial port can be driven by having two toggling
linesthat can be driven and one line that can be sensed. Thisallows a conversation with a
device that does not have an asynchronous serial port but that has two output signal lines
and one input signal line.

Theline TXA (also called PC6) is zero after reset if the cold-boot modeis not enabled. A
possible way to detect the presence of a cable on the programming port is for the cable to
connect TXA to one of the SMODE pins and then test for the connection by raising PC6
(by configuring it asa general output bit) and reading the SMODE pin after the cold-boot
mode has been disabled. The value of the SMODE pin is read from the SPCR register.
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Once you establish that the programming port will never again be needed for program-
ming, it is possible to use the programming port for additional 1/0 lines. Table F-1 liststhe

pins available for this alternate configuration.

Table F-1. RCM3400 Programming Port Pinout Configurations

Pin Pin Name Default Use Alternate Use Notes
1 RXA Serial Port A PC7—Input
2 GND
3 CLKA PBl—BlthseQr parallel
programmable input
4 VCC
3 Connected to reset
% 5 RESET generator U4
T l6 TXA Serial Port A PC6—Output
8 STATUS Output
Must be low when
9 |SVMODEO Input RCM 3400 boots up
Must be low when
10 SMODEL Input RCM 3400 boots up
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NOTICE TO USERS

Z-WORLD PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE-
SUPPORT DEVICES OR SYSTEMS UNLESS A SPECIFIC WRITTEN AGREEMENT REGARDING
SUCH INTENDED USE ISENTERED INTO BETWEEN THE CUSTOMER AND Z-WORLD PRIOR
TO USE. Life-support devices or systems are devices or systemsintended for surgical implantation into the
body or to sustain life, and whose failure to perform, when properly used in accordance with instructions for
use provided in the labeling and user’s manual, can be reasonably expected to result in significant injury.

No complex software or hardware system is perfect. Bugs are always present in a system of any size. In
order to prevent danger to life or property, it is the responsibility of the system designer to incorporate
redundant protective mechanisms appropriate to the risk involved.

All Z-World products are 100 percent functionally tested. Additional testing may include visual quality con-
trol inspections or mechanical defects analyzer inspections. Specifications are based on characterization of
tested sample units rather than testing over temperature and voltage of each unit. Z-World products may
qualify components to operate within arange of parameters that is different from the manufacturer’s recom-
mended range. This strategy is believed to be more economical and effective. Additional testing or burn-in
of anindividual unit is available by special arrangement.
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brdinit ......ccoovvevvivierene 74
/O drivers ....covevvvveenenen. 37
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keypad glPutFont ........cccccecenee 120 specifications .........c.coeeveeene 41
keyConfig .....cccceeeruenene 130 glRightl ..o, 124 busloading .......c.ccocerenennen. 46
keyGet .....ccoovveiiiene 131 glSetBrushType............ 122 digital 1/O buffer sourcing and
keylnit .....ccoccovniininnne 130 glSetContrast ............... 115 sinking limits ................ 50
keypadDef .............c..... 132 olSetPfStep ....ovvveenen. 120 dimensions ..o a2
keyProcess .......ccceeeeee 131 [0/ ESTTZ:!o IR 122 electrical, mechanical, and en-
keyScan .......ccceevenee 132 glUPL . 124 vironmental ................... a4
keyUnget ......cccovveeneee 131 gvscroll ..o 126 exclusion zone ................. 43

LCD display gIXFontlnit .......cccc.... 119 header footprint ................. 45
glBackLight ................. 114 gIXPutBitmap ............. 126 headers .......ccccviviinnnnn, 45
glBlankScreen ............. 115 gIXPutFastmap ............ 127 LCD/keypad module
gIBlocK ..o 116 TextCursorLocation .... 128 dimensions .........c....... 103
gIBuffLock .......ccceeeee. 122 TextGotoXY ......c.c.... 128 eectrical .....ocoovirennnne 104
glBuffUnlock .............. 122 TextPrintf ..o 129 mechanical .................. 104
gIDispONOff ................ 114 TextPutChar ................ 128 temperature ................. 104
giDownl ......ccccevereennene 125 TextWindowFrame ..... 127 Prototyping Board ............. 58
glFillCircle ......cccceueeen. 118 LCD/keypad module Rabbit 3000 DC characteris-
glFillPolygon ............... 118 displnit ..ccooeeveveieeee 113 (oS 49
glFillScreen ................ 115 displedOut ................... 113 Rabbit 3000 timing dia-
glFillVPolygon ............ 117 LEDS oo 113 Oram e 47
glFontCharAddr .......... 119 1] o] = = S 36 relative pin 1 locations ...... 45
glGetBrushType .......... 123 PACKET.LIB .....ceeveue 38 spectrum spreader ................. 48
olGetPfStep ...oovvveneee 120 RCM3400 ......cccovvreernnns 36 subsystems
giHScrall ... 125 RCM3400.LIB ............ 113 digital inputs and outputs .. 20
(o1 19T} 114 RS232.LIB ....ccccevvvvennns 38 switching modes ................... 17
gILeftl .o, 124 TCPIIP v 38
glPlotCircle ................ 118 readUserBlock .................. 33 T
glF otD_ot ..................... 123 sample programs ... 14, :_39, 72 TCP/IP PHMEr wovvreeeeee. o1
glPlotLine ..o 123 serial communication driv- technical SUPPOTt ......ovrvrn... 12
glPlotPolygon .............. 117 EFS v 38
glPlotVPalygon ........... 116 TCP/IP drivers .....cccceeveee 38
gliPrintf ..o 121 writeUserBlock ................ 33
glPutChar .......cccceuee. 121
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SCHEMATICS

090-0157 RCM3400 Schematic

www.rabbitsemi conductor.com/documentation/schemat/090-0157. pdf

090-0162 Prototyping Board Schematic

www.rabbitsemi conductor.com/documentation/schemat/090-0162. pdf

090-0156 LCD/Keypad Module Schematic

www.rabbitsemi conductor.com/documentation/schemat/090-0156. pdf

090-0128 Programming Cable Schematic

www.rabbitsemi conductor.com/documentation/schemat/090-0128. pdf

The schematics included with the printed manual were the latest revisions available at the
time the manual was last revised. The online versions of the manual contain links to the
latest revised schematic on the Web site. You may aso use the URL information provided
above to access the latest schematics directly.
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